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Important: Read me first!

First of all, it is important for you to know that this 11th 
edition in the Illustrator WOW! series has become a truly 
collaborative project. In order to provide you with the 
most thoroughly updated information in a timely manner 
(and as close as possible to the shipping of the new ver-
sion of Adobe Illustrator), this book evolved into a project 
that involves a large team of international experts working 
simultaneously. The process begins with Steven Gordon 
and myself acting as co-curators; Steven surfs web and 
print sources and collects potential artists and artwork 
we’d like to feature, then posts samples of these, along with 
submissions sent by readers and artists we’ve covered in 
the past, to a website where we can see the works and take 
notes about the art. I work with each co-writer to deter-
mine which sections they want to concentrate on, based 
on their expertise in Illustrator. For the artists/writers that 
often means asking them to focus on integrating new tools 
and functions into their current projects so they can share 
that knowledge with you. 

Our technical editor, Jean-Claude Tremblay, marks 
up the last edition in PDF, and then he and I continue to 
oversee every page of the book as it progresses. In addi-
tion to Jean-Claude and myself, the entire team of writ-
ers, as well as our stellar team of WOW! testers, test and 
critique each section as it develops. What this all means 
is that this book is the collaborative result of this amaz-
ing group of experts scattered around the globe, coming 
together by email, iChat, and PDF, and acrobat.com, to 
deliver the best book possible to you, the reader.

With the skyrocketing price of printing in full-color, 
and the fragile state of the economy for most of us, 
I looked for ways to bring down the cover price of the 
book. After consultations with the team, colleagues in the 
field, and Peachpit, we settled on a total rethinking of the 
focus of this book, which we’ve nicknamed “the leaner, 
meaner” Illustrator WOW! Book. With a renewed focus 

If you’re a beginner…

Beginners are of course most wel-

come to find inspiration in this 

book. However, be aware that the 

assumed user level for this book is 

intermediate through profession-

al. If you’re a beginning Illustrator 

user, please supplement this book 

with basic, beginning Illustrator 

instruction and training materials. 

In addition, don’t miss the free 

Illustrator training videos from 

the Adobe TV website: http://

tv.adobe.com/#pd+Illustrator.

ZenLessons folder on the DVD

Once you understand the con-

cepts of how the tools work, if 

you still find Illustrator cryptic, 

see the “ZenLessons” folder on 

the WOW! DVD. These lessons 

walk you through some of the 

basics of working with the Pen 

tool, Bézier curves, layers, and 

stacking order, helping you to 

learn to “think in Illustrator.” 

You’ll also find the “Zen of the 

Pen” PDF (by Sharon Steuer and 

Pattie Belle Hastings); these les-

sons include QuickTime movies to 

help you  with the Pen tool and 

Bézier curves. To be notified when 

Zen of Illustrator books and vid-

eos become available, please send 

an email with the subject “Zen” 

to: info@zenofillustrator.com.

http://tv.adobe.com/#pd+Illustrator
http://tv.adobe.com/#pd+Illustrator
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What’s on the WOW! DVD

WOW! technical editor Jean-Claude 

Tremblay collected his favorite Il-

lustrator-related plug-ins and soft-

ware on the WOW! DVD. You’ll also 

find relevant PDF excerpts from a 

number of great books, a year’s 

worth of Design Tools Monthly 

newsletters, samples of clip art 

from GoMedia, and of course, lots 

of artwork from the book for you 

to pick apart.

on creating art and design with Adobe Illustrator, we now 
leave the more basic and most technical aspects of the 
program, to books such as Mordy Golding’s Real World 
Adobe Illustrator CS5 (look for two chapters from this 
book in PDF format on the WOW! DVD).

It’s always sad to delete favorite artworks from previ-
ous editions, but it’s also inspiring and exciting to add 
dozens of new gorgeous examples of art, essential pro-
duction techniques, and time-saving tips—all generously 
shared by Illustrator WOW! artists worldwide. In addition 
to the contributing artists and coauthors, our amazing 
team of WOW! testers sets this book apart from all others. 
This team thoroughly tests every lesson and gallery to 
make sure everything actually works. We deliberately keep 
all lessons short to allow you to squeeze in a lesson or two 
between clients, and to encourage the use of this book 
within the confines of supervised classrooms. 

The user level for this book is “intermediate through 
professional,” which means that we not only assume that 
the reader has a reasonable level of competence with Mac 
and Windows concepts (such as opening and saving files, 
launching applications, copying objects to the Clipboard, 
and clicking-and-dragging), but also that you have a 
familiarity with most of Illustrator’s tools and functions. 
In addition, please see the pull-out card at the back of the 
book for a thorough summary of the shortcuts and con-
ventions that we’ll refer to regularly in the book (please 
see the “How to use this book…” section, following).

After you’ve read this book, I encourage you to read 
it again—you’ll undoubtedly learn something you missed 
the first time. The more experienced you become with 
Adobe Illustrator, the easier it is to assimilate all the new 
information and inspiration you’ll find in this book. I’m 
immensely proud of and grateful to everyone who works 
with me on this project. And I welcome you to the team.

Sharon Steuer

What’s new in CS5 (and CS4)?

New feature highlights for CS5 

include the Shape Builder tool, the 

Perspective tools, Bristle Brushes, 

variable width strokes and the 

Width tool, transparency in Gra-

dient Mesh, and the Artboards 

panel (for help with multiple art-

boards). New CS4 features (in case 

you missed them) include the Blob 

Brush tool, multiple artboards, the 

Gradient Annotator (for adjusting 

gradients directly on objects), and 

transparency in gradients. For a 

complete summary of Illustrator 

CS5 features, click the New Fea-

tures link in the bottom-left cor-

ner of the Welcome Screen, which 

you can open via Illustrator Help.

Course outline for teachers…

If you’re teaching a class in Illus-

trator, download the Illustrator 

CS5 WOW! Course Outline (by 

Lisa Jackmore and Sharon Steuer)

from: www.ssteuer.com/edu

www.ssteuer.com/edu


 xiv How to use this book…  

How to use this book…

While everyone is welcome to be inspired by the fabu-
lous work showcased in this book, please keep in mind 
that this Adobe Illustrator CS5 WOW! Book has been 
designed and tested for intermediate through profes-
sional-level users of Adobe Illustrator. That means that 
you’ll need to be familiar enough with the basics of Illus-
trator to be able to create your own art to follow along 
with the lessons. Unlike some books that do all the work 
for you, this book encourages experiential learning; as you 
follow along with the lessons, you’ll not only be mastering 
the techniques, but you’ll be creating your own art along 
the way. And to help you figure things out and inspire you 
further, this icon  tells you to look for the featured art-
work within that chapter’s folder on The Adobe Illustrator 

CS5 WOW! DVD (referred to hereafter as the WOW! DVD). 

Shortcuts and keystrokes

Please start by looking at the WOW! Glossary on the 
pull-out quick reference card at the back of the book for a 
thorough list of power-user shortcuts that you’ll want to 
become familiar with. The WOW! Glossary provides defi-
nitions for the terms used throughout this book, always 
starting with Macintosh shortcuts first, then the Windows 
equivalent (C-Z/Ctrl-Z). Conventions covered range 
from simple general things such as the C symbol for the 
Mac’s Command or Apple key, and the Cut, Copy, Paste, 
and Undo shortcuts, to important Illustrator-specific con-
ventions, such as C-G/Ctrl-G for grouping objects, and 
Paste In Front (C-F/Ctrl-F)/Paste In Back (C-B/Ctrl-B) 
to paste items copied to the Clipboard directly in front/
back of the selected object, and in perfect registration. 
Because you can now customize keyboard shortcuts, we’re 
restricting the keystrokes references in the book to those 
instances when it’s so standard that we assume you’ll keep 
the default, or when there is no other way to achieve that 
function (such as Lock All Unselected Objects). 

Look for the disc icon…

When you see this icon, 

find related artwork or files 

to deconstruct on the WOW! DVD 

(within that chapter’s folder). 

If the Welcome Screen is unwelcome, hide it by 
enabling “Don’t show again”

Access a hidden Welcome Screen from Help

Object Creation 	 Hold down keys until AFTER mouse button is released.

Constrains	objects	horizontally,	vertically,	or	proportionally.

Windows Finger Dance 
from The Zen of Illustrator, to help you learn, to “think in Illustrator”*

The	current	tool	becomes	the	last	chosen	Selection	tool.

Toggles	whether	Direct	Selection	or	regular	Selection	tool	is	accessed	by	the	Ctrl	key.

The	current	tool	becomes	the	Group	Selection	tool	to	select	entire	object.	Click	again		
to	select	next	level	of	grouping.	To	move	selection	release	Option	key,	then	Grab.

Toggles	whether	an	object,	path,	or	point	is	selected	or	deselected.

Constrains	transformation	proportionally,	vertically,	and	horizontally.

Leaves	the	original	object	and	transforms	a	copy.

With	Direct	Selection	tool,	click	on	or	marquee	around	an	object,	path,	or	point	to	toggle	
	selection/deselection.	Note: Clicking inside a filled object may select the entire object.

Clicking	on,	or	marqueeing	over	objects	with	Selection	tool	or	Group	Selection	tool,	
	toggles		selection/deselection	(Group	Selection	tool	chooses	objects	within	a	group).

Objects	will	be	drawn	from	centers.

Opens	dialog	boxes	with	transformation	tools.

Object Transformation Hold down keys until AFTER mouse button is released.

	click

click

click

click

Turns	cursor	into	the	Zoom-out	tool.	Click	to	Zoom	out.

Turns	cursor	into	the	Zoom-in	tool.	Click	or	marquee	around	an	area	to	Zoom	in.

Spacebar	turns	cursor	into	the	grabber	Hand

Turns	your	cursor	into	a	cross-hair.

Object Selection 	 Watch your cursor to see that you’ve pressed the correct keys.

Undo.	Use	Shift-Ctrl-Z	for	Redo.

Windows WOW! Glossary
and essential Adobe Illustrator shortcuts

 Ctrl Ctrl	always	refers	to	the	Ctrl	(Control)	key
	 Alt	 Alt always	refers	to	the	Alt	key

 Marquee	 With	any	Selection	tool,	click-drag	over	object(s)	to	select

 Toggle	 Menu	selection	acts	as	a	switch;	
choose	once	turns	it	on,	choosing	again	turns	it	off

 Contextual menu Right-click	to	access	contextual	menus		

 Group Ctrl-G	to	group	objects	together	onto	one	layer

 Copy, Cut, Paste, Undo  Ctrl-C,	Ctrl-X,	Ctrl-V,		Ctrl-Z

	 Select All, Deselect  Ctrl-A,	Ctrl-Shift-A

  With	Paste	Remembers	Layers	on	(from	the	Layers	panel	menu),	pasting	from	
	 Paste Remembers Layers the	Clipboard	places	objects	on	the	same	layers	that	they	were	on	originally;	

if	you	don't	have	the	layers,	Paste	Remembers	Layers	will	make	the	layers	for	you

  Use	Ctrl-F	to	paste	objects	on	the	Clipboard	directly	in	front	of	selected
	 Paste in Front  objects,	and	in	exact	registration	from	where	it	was	cut	(if	nothing	is	selected,	

it	pastes	in	front	of	current	layer	with	Paste	Remembers	Layers	off)

 	 Use	Ctrl-B	to	paste	objects	on	the	Clipboard	directly	in	back	of	selected	
 Paste in Back  objects,	and	in	exact	registration	from	where	it	was	cut	(if	nothing	is	selected,	

it	pastes	in	back	of	current	layer	with	Paste	Remembers	Layers	off)

		
 Toggle rulers on/off Ctrl-R	

 fx menu From	the	Appearance	panel,	click	the	fx	icon	to	access	effects	

 
 Select contiguous Hold	Shift	while	selecting	to	select	contiguous	layers,	swatches,	etc.

 Select non-contiguous	 Hold	Ctrl	while	selecting	to	select	contiguous	layers,	swatches,	etc.

 Toggle Smart Guides on/off	 Ctrl-U

 
 Turn objects into guides Ctrl-5

 Turn guides back into objects	 Ctrl-Alt-5	(you	must	select	the	guide	first;	if	guides	are	locked,	you	must	unlock	
them	first	from	the	contextual	menu	or	from	the	View	>	Guides	submenu)

   Find	related	files	or	artwork	in	that	chapter's	folder	on	the	WOW! DVD

 Illustrator Help	 Access	Illustrator Help	from	the	Help	menu

Perf

PerfFold

FoldPerF, Trim and Fold From THiS Side

*The Zen of Illustrator is copyright ©2011 SHARON STEUER
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 Turn objects into guides Ctrl-5

 Turn guides back into objects	 Ctrl-Alt-5	(you	must	select	the	guide	first;	if	guides	are	locked,	you	must	unlock	
them	first	from	the	contextual	menu	or	from	the	View	>	Guides	submenu)

   Find	related	files	or	artwork	in	that	chapter's	folder	on	the	WOW! DVD

 Illustrator Help	 Access	Illustrator Help	from	the	Help	menu

Perf

PerfFold

FoldPerF, Trim and Fold From THiS Side

*The Zen of Illustrator is copyright ©2011 SHARON STEUER
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Setting up your panels

In terms of following along with the lessons in this book, 
if you want your panels to look like most of our panels, 
you’ll want to sort swatches by name. Choose “Sort by 
Name” and “List View” from the Swatches pop-up menu. 
(Hold Option/Alt when you choose a view to set this as 
the default for all swatch kinds in the Swatches panel.)

In addition, Illustrator initially launches with an appli-
cation default that could inhibit the way Illustrator experts 
work. One of the most powerful features of Illustrator 
is that, when properly set, you can easily style your next 
object and choose where it will be in the stacking order, 
by merely selecting a similar object. But in order for your 
currently selected object to set all the styling attributes 
for the next object you draw (including brush strokes, live 
effects, transparency, etc.), you must first disable the New 
Art Has Basic Appearance setting from the pop-up menu 
in the Appearance panel (✓ shows if it’s enabled). Your 
new setting sticks even after you’ve quit, but needs to be 
reset if you reinstall Illustrator or trash the preferences.

How this book is organized…

You’ll find a number of different kinds of information 
woven throughout this book—all of it up-to-date for Illus-
trator CS5: Introductions, Tips, Techniques, Galleries, 
and References. The book progresses in difficulty both 
within each chapter, and from chapter to chapter.

1 	Introductions. Every chapter starts with a brief, general 
introduction. In these intros you’ll find a quick overview 
of the features referred to in the chapter Techniques and 
Galleries that follow, as well as a robust collection of tips 
and tricks that should help you get started.

2	Tips. Look to the information in the gray and red boxes 
for hands-on Tips that can help you work more efficiently. 
Usually you can find Tips alongside related text, but if 
you’re in an impatient mood, you might just want to flip 
through, looking for interesting or relevant Tips. The red 

Red Tip boxes

Red Tip boxes contain warnings or 

other essential information.

Tip boxes

Look for these gray boxes to find 

Tips about Adobe Illustrator. 

If you want your currently selected object to set 
all styling attributes for the next object, disable 
New Art Has Basic Appearance by choosing it 
from the pop-up menu in the Appearance panel

The Introduction sections begin every chapter 
with overviews of features

The Swatches panel viewed with “Sort by Name” 
and “List View” selected

With the All Swatches icon selected, choose 
“Sort by Name” and then “List View” from the 
Swatches pop-up menu

2

1

 2 Chapter 1 Your Creative Workspace Chapter 1 Your Creative Workspace 3 

IntroduCtIon

this has to stay her for the TOC
Your Creative Workspace

OK, this might not seem like sexy WOW! stuff, but to save 
time and stay focused on being creative, you need to work 
efficiently. In this chapter you’ll find tons of things you 
might have missed or overlooked. You’ll find tips for cus-
tomizing your workspace and in-depth coverage of newer 
organizational features such as working with multiple art-
boards and the multi-functional Appearance panel, which 
can take the place of several panels.

organIzIng Your WorkspaCe

You can save time and frustration in the long run if you 
spend a few minutes setting up custom workspaces and 
creating your own document profiles. The work you do 
to create the elements for a Flash animation is probably 
different from what you do to create a technical illustra-
tion or the layout for a series of brochures. Not all panels 
are needed for every job, but by organizing all that you 
definitely need—eliminating all you won’t need or might 
only rarely need—you’ll be able to locate quickly just what 
you need when you need it. In addition, the Control and 
Appearance panels often contain the same information 
found in the special purpose panels, permitting you to 
close some of those panels and streamline your interface 
even more than you might think possible (see the “Using 
the Appearance Panel” section later in this chapter).

In deciding which panels you want on your desktop 
for any given project, you’ll probably first want to cluster 
panels that you will frequently use in sequence, such as 
Paragraph and Character Styles or Transform and Align. 
You’ll also decide where each panel or group of panels 
should live, and whether, when you collapse them to get 
them out of your way, you want them to collapse to their 
icon and label, or all the way down to their icon. When 
you have everything arranged to your liking, choose Save 
Workspace from either the pop-up menu in the Appli-
cation bar, or from Window > Workspace. Once you’ve 

created and saved a custom workspace, its name will 
show up in the Window > Workspace submenu and on 
the Application Bar (by default at the top of your working 
area). Switch between different workspaces by choosing 
a name. Note that any changes to a workspace, such as a 
panel opened or moved, are temporarily saved when you 
quit Illustrator so that you can always open Illustrator 
right where you left off. To restore a workspace to its origi-
nal configuration, open the list of workspaces and reselect 
it. Following are some tips for arranging your panels:

• dock panels to the edges of your screen or, if you want 
them closer to your work, drag them around freely. (The 
Control panel docks to the top or bottom of the screen.)

• resize most panels once they’re open. Look for the dou-
ble-headed arrow when hovering over an edge to see if the 
panel can be dragged in that direction.

• Collapse and expand free-floating and fully 

expanded columns to their title bar by double-clicking 
the dark gray bar next to the panel name. (If the open 
panel is one in a column of icons that has been tempo-
rarily opened by itself, it can’t be reduced to its title bar.) 
Double-click on the name of any open panel to reduce it 
to its smallest size while still allowing it to remain open. 
Experiment with expanding and minimizing open panels 
in your workspace to get used to how the panels work, 
and you’ll save time and frustration later when you want 
to get a panel out of your way quickly.

• If you need multiple panels open at once, place each 
panel you want open in a separate column (drag to the 
side of an existing column until you see the vertical blue 
bar). Only one item in a column of panel icons can be 
open, but one from each column can be open simultane-
ously and will remain open until you manually close it by 
clicking on its double arrow in the upper right corner. The 
exception is if you have enabled Auto Collapse Icon Pan-
els in Preferences > User Interface. In that case, clicking 
anywhere outside a panel that was opened from an icon 
will close it for you. Since panels are “spring-loaded,” you 
can still drag items into them even when they’re closed.

tabbed docs & the app Frame

• Change whether documents 

are tabbed (the default) or 

not through Preferences > User 

Interface. 

• If more documents are open 

than are visible on tabs, a dou-

ble-arrow at the tab bar’s right 

will list them.

• Drag documents away from the 

tab to make them free-floating.

• Drag object layers from one 

document into another by drag-

ging over that document’s tab. 

The tab will spring open to let 

you drop the object in place.

• On a Mac, you can also turn on 

the Application Frame (disabled 

by default) from the Window 

menu. The frame contains all 

the panels and documents, and 

everything you can do in AI 

takes place within the frame.

note: You should turn off the Appli-
cation Frame in an extended moni-
tor setup (or video projection).

When you click the double arrow in the upper 
right, open panels will cycle through contracted 
and expanded states, which will vary depending 
on how you’ve customized the panel; customize 
the width manually when the cursor turns into a 
double-headed arrow, allowing you to click-drag 
to resize the panel

Dock and stack panels with different results by 
watching where the blue highlight shows up

A double-headed arrow in the upper left (next to 
the panel name), indicating that you can display 
more, or fewer, options in the panel; the fewest 
options will be shown by default

Magically appearing panels

If you have used Tab or Shift-tab 

to hide your panels, mouse care-

fully over the narrow strip just be-

fore the very edge of the monitor 

where the panels were and they’ll 

reappear, then hide themselves 

again when you move away.

To minimize a panel opened from a column of 
panels that have been reduced to icons, click the 
double arrow in the upper right (you can’t mini-
mize it by double-clicking the dark gray bar)
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arrows , red outlines, and red text found in tips (and 
sometimes with artwork) have been added to emphasize 
or further explain a concept or technique. 

3	Techniques. In these lesson-oriented sections, you’ll find 
step-by-step techniques gathered from artists and design-
ers around the world. Most WOW! techniques focus on one 
aspect of how an image was created, though we’ll some-
times refer you to different WOW! chapters (or to a specific 
step-by-step Technique, Tip, or Gallery where a technique 
is introduced) to give you the opportunity to explore a 
briefly covered feature more thoroughly. Feel free to start 
with almost any chapter, but be aware that each technique 
builds on those previously explained, so you should try 
to follow the techniques within each chapter sequen-
tially. Some chapters include Advanced Technique les-
sons, which assume that you have assimilated all of the 
techniques found throughout the chapter. The Mastering 
Complexity chapter is packed with lessons dedicated to 
advanced tips, tricks, and techniques.  

4	Galleries. The Gallery pages consist of images related to 
techniques demonstrated nearby. Each Gallery piece is 
accompanied by a description of how the artist created 
that image, and may include steps showing the progres-
sion of a technique detailed elsewhere.

5	References. At the back of the book, you’ll find one 
appendix listing the artists featured in this book, and 
another listing the resources we’ve referred to, most of 
whom have included a demo or additional information 
for you on the WOW! DVD. In addition to these sections, 
you’ll also find a General Index, and a pull-out quick ref-
erence card containing Mac and Windows versions of a 
WOW! Glossary and Finger Dance shortcut sequences. 
Finally, within the text you’ll occasionally be directed to 
Illustrator Help to find specific information that’s well-
documented in the Adobe Help Viewer. To access this, 
choose Help > Illustrator Help.

3

4

5

Access Illustrator Help from the Help menu

Everything’s under Window…

Almost every panel in Illustrator 

is accessible through the Window 

menu. If we don’t tell you where 

to find a panel, look for it in the 

Window menu!
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G A L L E R Y

Ann Paidrick

Ann Paidrick enhanced her vase 

illustration from the previous les-

son by adding the patterned pear 

wallpaper to the background. 

Paidrick locked all the layers of the 

fi nished vase and, on a new layer 

beneath these locked layers, placed 

a photograph of the wallpaper 

(saved as .jpg) as the background. 

With the Pen tool, she drew rough outlines 

where the distorted pears would be, and then 

turned these outlines into guides (C-5 /Ctrl-5). 

On a separate layer above the background 

wallpaper, she placed another photo of the 

wallpaper, this time one that she had cropped 

in Photoshop to fi t between the top and bot-

tom of the clear glass. In order to use an Illus-

trator envelope to distort the cropped part of 

the photo, she had to fi rst embed the photo by 

selecting the Embed icon in the Control panel. 

Paidrick then chose Object > Envelope Distort > 
Make with Mesh (6 rows, 8 columns). She used 

the Direct Selection tool to adjust the enve-

lope mesh object into the shape of the interior 

of the glass. To add more rows and columns, 

Paidrick clicked with the Gradient Mesh tool 

and added additional mesh points with the 

Add Anchor Point tool. She continued to adjust 

the mesh points, referring to her guides until 

she was satisfi ed with the distortion results. 

To make the envelope mesh object fi t into the 

vase shape, on a new layer above, she drew 

a closed path with the Pen tool, selected the 

envelope mesh object, then chose Object > 
Clipping Mask > Make. 

PAIDRICK
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� e myriad Bristle Brushes presented Greg Geisler with 
an in� nite variety of brushes to create his expressive 
painterly portrait, “Blue Mirror.” Commissioned by Adobe 
Systems, you can � nd this � le, and a PDF ReadMe � le 
explaining more about how he made it, on the WOW! DVD 
and in the Sample Art folder installed with Illustrator. 

1 Placing the initial sketch, and customizing Bristle 

Brush Options. Geisler placed his distorted Photoshop 
sketch (PSD) as a Template layer. He opened the Bristle 
Brush Library (Window > Brushes Libraries > Bristle Brush 
Library) and clicked on the 1-pt Round Bristle Brush, 
which automatically loaded the brush into the Brushes 
panel. Geisler next duplicated that brush in the Brushes 
panel (by dragging its icon to the New Brush icon) and 
then double-clicked on the brush in the Brushes panel so 
he could change several settings in Bristle Brush Options. 
He made changes to Bristle � ickness, adjusted Paint 
Opacity and increased the Sti� ness, and then named it 
and clicked OK. On a layer above the template, he used 
this new brush to create the base sketch for the entire il-
lustration. Geisler kept the Brushes panel and the Bristle 
Brush Library open throughout the drawing session, so he 
could continue to duplicate and customize brushes as his 
drawing progressed. For this layer, he created three di� er-
ent variations of the 1-pt Liner brush. 

Painterly Portraits
Painting in Layers with Bristle Brushes

Overview: Place a sketch as a tem-
plate; draw with customized Bristle 
Brushes; continue to paint with cus-
tom brushes into separate layers; cre-
ate frame.

G
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Adding shadows with a wide, fairly opaque 
Bristle Brush

The template; a distorted Photoshop sketch

1

The initial Bristle Brush sketch made with three 
variations of a Round Point Bristle Brush; the 
Bristle Brush Options 
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Expressive Strokes

Almost everything you thought you knew about styling 
strokes in Illustrator has changed. A path can be manu-
ally adjusted with the Width tool to emulate calligraphy, 
and its form (profile) can be saved in the Stroke panel and 
applied to another path. Art Brushes can have start and 
end points protected from alteration, have flexible scale 
options, and can wrap to fit into tight corners. Tiles for 
Pattern Brushes offer several scaling options to use with 
spacing, creating completely different looks when applied 
to paths. The Bristle Brush emulates traditional brushes, 
ranging from a round sable to a flat fan, with the texture 
of multiple “bristles” added at each stroke of the brush. 
The Symbols we paint with are also discussed here, even 
though strictly speaking they aren’t “strokes.” 

Width Tool

The Width tool (Shift-W) varies the width of strokes 
created with the drawing and geometric shape tools, or 
Art and Pattern Brushes. The path doesn’t have to be 
selected; hover over it with the Width tool and the path 
will highlight, along with hollow diamonds indicating 
existing width points that were either set automatically, 
such as the end points of a path, or that you have set. As 
you move your cursor over the path, still hovering, a hol-
low diamond moves with your cursor, ready to become a 
width point at whatever location along the path you click 
on. You can modify paths between two existing width 
points, and can create either a continuous, flowing curve, 
or a discontinuous one with a sharp break between sec-
tions of the curve). If the width points are spaced apart, 
the path gradually gets wider or narrower from one point 
to the next in a continuous curve. If the width points 
are placed on top of each other, you create a sharp break 
between the two widths, causing the curve to abruptly 
widen or narrow, much like adding an arrowhead to the 
path. Modify strokes on either side of the path either by 

Swapping fill and stroke

Press the X key to toggle the focus 

of the Stroke or Fill box on the 

Tools and Color panels, and press 

Shift-X to swap the actual at-
tributes or contents of the Stroke 

and Fill boxes. For example, if 

you start with a white fill and a 

black stroke, you will have a black 

fill and a white stroke after you 

press Shift-X. Note: Because strokes 
can’t contain gradients, Shift-X will 
not work when the current fill is a 
gradient.

Introduction

 This is for the TOC, leave it here
Part of this text frame MUST
be on the page for this to work!

Creating discontinuous curves from continuous 
curves with the Width tool when creating a flag
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Deleting arrowhead presets

To make custom arrowheads, be 

sure to only modify the file hold-

ing the default presets. If you 

delete any arrowheads in that file, 

you’ll have to reinstall Illustrator 

to get them back again.
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adjusting the stroke weight evenly along the path, or plac-
ing more weight on one side of the path than the other. 
Your custom stroke profile is temporarily stored in the 
Stroke panel, making it possible to apply the same stroke 
to as many paths in the document as you wish. An aster-
isk in the Appearance panel beside the Stroke denotes a 
width profile. You can also save a custom profile as part 
of a Graphic Style and/or to the Profiles list using the Save 
icon at the bottom of the Stroke panel list. The Reset icon 
restores the default width profiles, replacing any custom 
profiles you’ve saved, so be careful about choosing to 
restore the default width profiles. You can modify width 
points in a variety of ways with the Width tool:

•	To open the Width Point Edit dialog, double-click on 
a path or existing width point. Numerically input the 
stroke weight for each side of the path, and/or choose to 
have adjoining width points adjusted at the same time.

•	To interactively adjust the width point, click-drag on 
a handle to symmetrically adjust the stroke width.

•	To adjust one side of a stroke, press Option/Alt while 
dragging on a handle.

•	To adjust the position or width of just some of the 

points, Shift-click to first select them, then Shift-drag to 
move them in tandem or adjust their width. 

•	To adjust all the points at once, select one width point 
and Shift-drag to adjust all the rest in tandem. 

•	To copy selected points, hold Option/Alt as you drag.
•	To delete a selected width point, press the Delete key.
•	To deselect a width point, press the Esc key, hold 

down Option/Alt and click on an empty space, or use 
C-Shift-A/Ctrl-Shift-A to deselect all (holding down C or 
Ctrl does not temporarily switch you to the Selection tool).

The Expanded Stroke Panel

The Stroke panel controls settings for the many different 
types of strokes, from how they align to the path of an 
object to how they join at corners. Dashed lines, end caps, 
and arrowheads all are part of the Stroke panel, as well as 
stored width profiles, from a normal even width to a fully 

Save those width profiles

The Reset icon in the Strokes panel 

deletes all custom width profiles 

and restores the default profiles. 

To first save your width profiles, 

apply them to an object, then save 

that object’s Graphic Style in the 

Graphic Styles panel. 

(Top) The starting stroke with width points al-
ready added and adjusted; (middle) the width 
point at the right end adjusted again to make 
the end wider and Adjust Adjoining Width Points 
disabled; (bottom) with Adjust Adjoining Width 
Points enabled when adjusting the same original 
right-end width point—starting stroke shown for 
clarity in red on top of both adjusted strokes.

Shift-selecting just some contiguous (shown) or 
non-contiguous (not shown) width points on a 
Pattern Brush stroke, releasing Shift, then moving 
them all at once 

Use the dialog (shown above) to enable Adjust 
Adjoining Width Points (disabled by default), or 
select a point and hold the Shift key down while 
adjusting it in order to bypass opening the dialog
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calligraphic profi le. Here you can also customize and 
save your carefully craft ed stroke profi les aft er creating a 
variable-width stroke, and preview how your path joins 
to an arrowhead. Adjust the way dashes follow a path, 
and scale arrowheads to suit.

Making ends meet

Sometimes stroked lines seem to match up perfectly 
when viewed in Outline mode but they visibly overlap 
in Preview mode. You can solve this problem by select-
ing one of the three end cap styles in the Strokes panel.
Th e default Butt cap causes your path to stop at the end 
anchor point and is essential for creating exact placement 
of one path against another. Th e Round cap is especially 
good for soft ening the eff ect of single line segments. Th e 
Projecting cap extends lines and dashes at half the stroke 
weight beyond the end anchor point. Cap styles also 
aff ect the shape of dashed lines.

Corners have joins that serve a similar purpose to 
end caps. Th e Join style in the Stroke panel determines 
the shape of a stroke at its corner points; the inside of the 
corner is always angled. Th e default Miter join creates a 
pointy corner, with the length of the point determined by 
the width of the stroke, the angle of the corner (narrow 
angles create longer points), and the Miter limit setting 
on the Stroke panel. Th e default Miter join (with a miter 
limit of 10x) usually looks fi ne, but can range from 1x 
(which is always blunt) to 500x. Th e Round join creates 
a rounded outside corner with radius of half the stroke 
width. Th e Bevel join creates a squared-off  outside corner, 
equivalent to a Miter join with the miter limit set to 1x.

Dashes behave like short lines, and therefore have 
both end caps and, potentially, corner joins. End caps 
work with dashes exactly as they do with the ends of 
paths—each dash is treated as a very short path. However, 
if a dashed path goes around the corner, it can make that 
turn in one of two ways: Th e spacing between the dashes 
can be precise and constant, so the dash won’t necessarily 
bend around a corner, or even reach to it, or you can click 

Stroke panel with width profiles list; save or 
delete one custom width profile at a time; re-
setting the defaults removes all custom width 
profiles

(Left) Choosing to align with mathematically 
precise spacing; (right) with adjusted spacing for 
visual appearance, aligning dashes to corners and 
path ends, which adjusts the space between to 
fit more uniformly
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A path shown first in Outline, then in Preview 
with a Miter join, Round join, and Bevel join
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the “Aligns dashes to corners and path ends, adjusting 
lengths to fit” icon. Dashes won’t be precisely spaced, but 
will look tidy at the corners. The command affects dash 
spacing for other shapes, from circles to stars, as well.

One more “end” to a path is an arrowhead, and the 
Stroke panel now offers a choice of both the types of 
arrowheads and how they are affixed to the ends of the 
paths. Click on the Arrowheads pop-up list to choose to 
attach an arrow or feather to the start or end of the path. 
You can then scale it proportionally or disproportionally, 
reverse the start and end, or align the arrowhead so that 
either the tip or the end of the arrow meets the end of the 
path. To remove an arrowhead (or feather), choose None 
from the list. You can add custom arrowheads to the list 
without removing any of the default arrowheads (you’d 
have to reinstall Illustrator to make them available again 
if you removed them). Both dash alignment options and 
arrowheads can be modified again at any time. 

Brushes

Illustrator’s Calligraphic, Art, Scatter, Bristle, and Pattern 
brushes can mimic traditional art tools, create photoreal-
istic imagery, or provide pattern and texture to your art. 
You can either create brush strokes with the Brush tool, or 
you can apply a brush stroke to a previously drawn path.

Calligraphic Brushes create strokes that mimic real-
world calligraphy pens, brushes, or felt pens. You can 
define a degree of variation for the size, roundness, and 
angle of each “nib.” You can also set each of these attri-
butes to respond to a graphics tablet and stylus (like the 
Wacom) with a variety of different pen characteristics 
(with a mouse, you can only use Fixed or Random).

Art Brushes consist of one or more pieces of art-
work that get fitted to the path you create with them. 
You can use Art Brushes to imitate traditional painting 
media, such as drippy ink pens, textured charcoal, spatter 
brushes, dry brushes, watercolors, and more. Or an Art 
Brush can represent real-world objects, such as a petal, a 
leaf, or a ribbon, a flower, decorative flourish, or train. You 

Creating custom arrowheads

Illustrator Help provides directions 

for locating the Arrowheads file 

on your computer. The file con-

tains instructions for customizing 

and saving arrowheads without 

overwriting the original file.

Where’s the Blob Brush?

Find information on the Blob 

Brush in the Rethinking Construc-
tion chapter; even though it’s first 

applied like a brush, it’s really 

more of a modern, fluid method 

for constructing objects.

Using the Arrowheads section of the Stroke 
panel to align the arrowhead so the tail of the ar-
rowhead joins the end of the path with the head 
extending beyond (left and as shown in the dia-
log), or to align the arrowhead so the tip of the 
arrowhead joins the end of the path (right)

Graphics tablets & brushes

Bristle Brushes, which mimic 

painter’s brushes, respond to every 

hand gesture when using a tablet 

and pen, such as the Wacom. The 

Wacom 6D Art or Art Pens also 

easily retain the appearance of 

the individual bristles, while allow-

ing full rotation to create unique 

strokes that imitate real brushes. 

A mouse is much more limited.
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can modify Art Brushes and their strokes using a num-
ber of different paramters, including variables affected by 
pressure (if you’re using a Wacom tablet and pen). Art 
Brush marks can be made to scale proportionately to fit 
the length of your path, or stretched to fit. You can also 
scale your brush non-proportionally by restricting the 
area of the Art Brush that can stretch, using two guides to 
create a segmented brush (choose Stretch Between Guides 
for the Scale option). Either or both ends of the brush are 
then protected from being stretched, and the middle por-
tion is stretched to fill in the remaining length. This allows 
you to stretch the stem of a rose, for instance, without 
stretching the blossom itself. You can further modify an 
Art Brush with colorization methods, such as choosing 
to vary a key color by tint or hue. Modify the way the Art 
Brush follows a path by flipping its direction, and use the 
Overlap option to determine whether or not to allow it to 
overlap itself when turning a corner. You can also use the 
Width tool to modify an Art Brush.

Use Scatter Brushes to scatter copies of artwork along 
the path you create with them: flowers in a field, bees in 
the air, stars in the sky. The size of the objects, their spac-
ing, how far they scatter from the path, and their rotation 
can be set to a Fixed or Random amount or, with a graph-
ics tablet, can vary according to characteristics such as 
pressure or tilt. You can also align the rotation of the scat-
tered objects to the direction of the path, or to the edges 
of the page. Change the method of colorization as you 
would with a Calligraphic or Pattern Brush.

Use Pattern Brushes to paint patterns along a path. To 
use a Pattern Brush, first define the tiles that will make up 
your pattern. For example, a train has an engine, rail cars, 
links, and a caboose. Each of these constitutes a tile where 
you have the start of the path, the middle (the side tile), 
the tiles that turn either an inside or outside corner, and 
the end of the path. The tiles must be made as individual 
art and stored in the Swatches panel before you can make 
your Pattern Brush. Afterwards, however, you can delete 
them from Swatches. In the Pattern Brush Options dialog, 

The Scatter Brush dialog varies how the artwork 
is scattered along a path

Using the Width tool to alter an Art brush stroke 
modified by Stretch Between Guides option

Altering Pattern Scale and Spacing to create a 
very different look to the brush
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select a tile, then click on the swatch name below the tiles 
that you want assigned to that tile. You can customize set-
tings for how the tiles fi t to, or fl ip along, the path, and to 
alter their color. You can also vary the appearance of the 
Pattern Brush, how it fi lls sharp angles (by altering the 
Scale in both Fixed parameters and those aff ected by tab-
let features), and the spacing between tiles. 

Bristle Brushes emulate traditional paint brushes, 
showing both the texture of the bristles and the tip shape, 
which can be round, fl at, fan-shaped, etc. To create a 
Bristle Brush, select it as the New brush type and, in the 
Bristle Brush Options dialog, choose a tip shape. From 
there, modify the brush’s bristle length, density, and thick-
ness; whether or not the bristles are stiff  or soft ; and how 
opaquely it applies the paint. Bristle Brushes use paint 
opacity for their eff ect, but even a 100% Opacity isn’t com-
pletely opaque. Change Opacity on the fl y with the num-
bers on the keyboard. Because calculating transparency 
for printing oft en takes a long time, a dialog warns that 
if you have more than 30 Bristle Brush strokes, you may 
want to select some or all of the Bristle Brush strokes and 
choose Object > Rasterize to set raster settings for them 
before you attempt to print. 

Working with brushes

Th e following describes functional features that apply to 
most or all brushes:

•	to create art, Scatter, and Pattern Brushes, create the 
artwork for them from fairly basic artwork, including 
compound shapes, blends, groups, and some live eff ects 
such as Distort & Transform or Warp. You can’t create 
brushes from art that uses gradients, mesh objects, raster 
art, and advanced live eff ects such as Drop Shadow or 3D.

•	to modify the art that makes up a brush, drag it out 
of the Brushes panel, edit the object, then drag it back into 
the Brushes panel. Use the Option/Alt key as you drag to 
replace the original art with the new art. 

•	to set application-level preferences for all brushes, 
double-click the Paintbrush tool. (Th e new preferences 

draw inside and Bristle Brushes

Bristle Brushes are a good candi-

date for the Draw Inside mode 

(see the Rethinking Construction 

chapter). You can add the bristle 

texture to a vector shape while re-

taining some or all of the original 

color; Draw Inside also constrains 

the strokes inside the object, en-

suring stray bristle marks are auto-

matically masked.

Symbols vs. Scatter Brushes

Because it’s easy to edit symbols, 

using symbols can be preferable to 

using Scatter Brushes, whose attri-

butes will be applied to the whole 

set. The ability to delete individual 

symbols within a set is another 

potential advantage over scatter-

ing objects with a brush stroke, 

which must be expanded before 

individual objects can be deleted 

from it.

Using a Bristle Brush (the Footprint brush show-
ing) to draw inside a selected path, and the Lay-
ers panel showing the Clipping Paths created by 
Draw Inside
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will apply to work you do with the brushes going forward, 
but won’t change existing work.) 

•	to modify the properties of a single brush stroke, 
select it, then choose Options of Selected Object in the 
Brush panel’s menu. If you’ve used the Width tool to mod-
ify the stroke, your options include using the width points 
to calculate the profi le for your next strokes.

•	to choose how to apply modifi cations to existing 
brush strokes, in the brush’s Options dialog choose Leave 
Strokes to create a duplicate brush, or Apply to Strokes to 
modify every use of the brush in the document.

•	When keep Selected and Edit Selected Paths are both 

enabled, the last drawn path stays selected; drawing a 
new path close to the selected path will redraw that path. 
Disabling either of these options will allow you to draw 
multiple brush strokes near each other, instead of redraw-
ing the last drawn path. 

SYMBolS 
Working with symbols in Illustrator saves fi le size (since 
objects converted to symbols aren’t duplicated in the fi le), 
provides consistency whenever the same artwork needs 
to be used more than once, and makes it easy to update 
objects in your artwork simply by editing the symbol to 
change it wherever it has been used. Symbols can be made 
from almost any art you create in Illustrator. Th e only 
exceptions are a few kinds of complex groups, such as 
groups of graphs, and placed art (which must be embed-
ded, not linked). Symbols are edited and stored using the 
Symbols and Control panels, and are manipulated in your 
artwork with the Symbolism tools:

•	to store selected artwork as a symbol, drag it into the 
Symbols panel (or click on the New Symbol icon in the 
panel). Use the Libraries Menu icon to save the current 
symbols to a new library, or to load other libraries.

•	to add a single instance of a symbol to your docu-

ment, drag it into your document or, with it selected, 
click on the Place Symbol Instance icon. Drag a symbol 
instance into your document as oft en as you like, but you 

Modifying based on Width Points using Options 
of Selected Object for an Art Brush that has al-
ready been modified with the Width tool

Symbolism Tools Options dialog

Storing symbols in the Symbols panel, with ac-
cess to other symbol libraries, editing commands, 
and the Symbol Options dialog

Quick access to Symbol features on the Control 
panel with a symbol in the artwork selected; the 
Reset button not grayed out indicates the symbol 
has been transformed and the Replace pop-up 
gives immediate access to the loaded Symbols 
library
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can only use the Place Symbol Instance icon once. It’s 
most useful for modifying the symbol (see below).

•	To modify a symbol without modifying the original 

symbol in the Symbols panel, click either the Break 
Link button in the Control panel or the “Break Link to 
Symbol” icon in the Symbols panel. 

•	To modify a symbol and all instances of it already 
in the document, place or drag it into your docu-
ment, then click on the Edit Symbol button in the 
Control panel. Your symbol will be placed in isolation 
mode. After you modify it and exit isolation mode, all 
instances of the symbol, including the symbol in the 
Symbols panel, are updated.

•	To modify a symbol in the Symbols panel when you 

have already broken the link, Option/Alt-drag the 
modified symbol on top of the symbol in the Symbols 
panel. This will replace the original symbol with the 
modified artwork and update all instances of the origi-
nal symbol.

•	To restore a symbol to its original size and orienta-

tion after transforming it, click the Reset button in the 
Control panel.

•	To quickly find all instances of a symbol in your 
artwork, target the symbol either in the Symbols panel 
or in your artwork and choose Select All Instances from 
the Symbol panel’s menu.

•	To replace one symbol with another without open-

ing the Symbols panel, select the symbol in the art-
work and click on the Replace list arrow in the Control 
panel. A miniature Symbols panel opens, which allows 
you to swap out symbols.

•	To add a sublayer to a symbol’s artwork, in isola-
tion mode click on the topmost layer with the symbol’s 
name, and then click on the New Sublayer icon. You 
can’t add sublayers to a <Group> or <path>. 

•	To add a new layer above a group or path sublayer 

at the same hierarchy level, target the layer, then 
Option-click/Alt-click on the New Layer icon. If the 
layer remains a normal layer (not a group or a path), 

Symbols for Flash

When creating symbols for use in 

Flash, take advantage of Illustra-

tor’s built-in features for making 

them ready for use:

•	 Enable 9-slice scaling, often used 

for buttons and other interface 

elements when creating a Flash-

based website, from within 

Illustrator. Doing so reduces 

distortion when scaling objects, 

especially noticeable with ele-

ments such as buttons that have 

custom corners.

•	Assign a Registration point to 

the symbol in Illustrator. The 

Registration point affects any 

transformations applied inside 

Illustrator, and Flash also uses 

the Registration point as the 

origin point (0,0) for Motion 

Presets and other commands 

used to animate or modify the 

symbol. 

•	Give a symbol a unique Instance 

name in the Control Panel so 

Flash can identify it when using 

Action Script commands. This is 

important when creating inter-

face elements, such as buttons, 

that are otherwise identical.

Some Control panel options for modifying sym-
bols, including providing a Flash instance name 
and a Reset button for restoring a symbol to its 
original size



 94 Chapter 4 Expressive Strokes

you can continue to add new layers at that level merely by 
clicking on the New Layer icon.

Working with the Symbolism tools

Th ere are eight diff erent Symbolism tools. Use the Symbol 
Sprayer tool to spray selected symbols onto your docu-
ment, creating a symbol set. You can’t select individual 
instances inside a set with any of the selection tools. 
Instead, modify them with any of the other Symbol tools. 
To display a ring of tools in your document in order to 
select a new one, press Control-Option/Ctrl-Alt while 
clicking and holding in an empty spot in your document 
then drag to a new icon before releasing your mouse. Add 
symbols to a selected set by selecting a symbol in the Sym-
bols panel—the symbol can be the same as or different 
from the symbols already present in the instance set—and 
spray. To add or modify symbols in a set make sure you’ve 
selected both the set and the corresponding symbol(s) in 
the Symbols panel that you want to affect. The Symbolism 
tools will only affect those symbols in a selected set that 
are also selected in the Symbols panel, thus making it easy 
to modify just one of the symbols in a mixed set. 

To adjust the properties of the Symbolism tools, 
double-click on one to open Symbolism Tools Options. 
Vary the diameter (the range over which the tool oper-
ates), the rate at which it applies a change, and the density 
with which it operates on a set. If you’re using the default 
Average mode, your new symbol instances can inherit 
attributes (size, rotation, transparency, style) from nearby 
symbols in the same instance set. For example, if nearby 
symbols are 50% opaque, symbols added to the set will 
also be 50% opaque. You can also change the default Aver-
age mode to User Defined or Random. (See Illustrator 
Help for more information about choosing User Defined.)

To remove symbols from an existing instance set, use 
the Symbol Sprayer tool with the Option/Alt key, and 
click on an instance to delete it (or click-drag your cur-
sor over multiple instances—they’re deleted when you lift  
your cursor).

Control-Option-click/Ctrl-Alt-click on an empty 
spot in the document to reveal this heads-up 
display of all the Symbolism tools; drag to the 
desired tool and release the mouse.

Adding a new layer at the same level as a path 
sublayer by Option-clicking/Alt-clicking on the 
Create New Layer icon

Using the Symbolism tools to modify the original 
set (top) for greater variety (bottom)
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G A L L E R Y

Don Jolley

This sampler by Don Jolley, using his 6D Art Pen, 

demonstrates the tremendous variety you get 

from brushes that ship with Illustrator. When 

you add a Wacom pressure-sensitive pen and 

tablet to these out-of-the-box brushes, you can 

introduce even more variety into your strokes; 

the standard Grip Pen registers pressure, tilt, 

and bearing, and the optional, more sensitive 

6D Art (Intuos3) or Art (Intuos4) Pens add the 

ability to vary each stroke with rotation. The 

Bristle Brush responds particularly well to the 

Art Pens, adding a new dimension to painting. 

You can manually transform your stroke (except 

those made with the Calligraphic, Scatter, or 

Bristle Brushes), by modifying its profile with 

the Width tool, and then saving that profile to 

apply to other strokes.

Jolley
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SteUer

Brushes & Washes
Drawing with Naturalistic Pen, Ink, & Wash

Overview: Start with a placed image 
as a template; create a custom Calli-
graphic brush; create variations on the 
brush to apply to strokes; add a wash 
layer below the ink layer.

1

It’s easy to create spontaneous painterly and calligraphic 
marks in Illustrator—and perhaps with more fl exibility 
than in many pixel-based programs. Sharon Steuer drew 
this sketch of Honfl eur, France, using a Wacom tablet, 
her Art Pen for the Intuos4, and two diff erent Illustrator 
brushes. She customized a brush for the thin, dark strokes 
and used a built-in brush for the underlying gray washes.

1 Importing artwork and using template layers. If you 
want to use a sketch or photo as a reference, set it up as 
a non-printing template layer. For her template image, 
Steuer scanned a small photo of Honfl eur. To place an 
image as a template layer so it can be easily resized, choose 
File > Place, enable the Link checkbox, and click the Place 
button. If the image imports at too large a size, hold down 
the Option-Shift /Alt-Shift  keys (to resize proportionally 
from the center) and drag on a corner of the bounding 
box until the image is the size you want. Th en double-click 
on the layer to open the Layers Options dialog and enable 
the Template option. Illustrator automatically dims the 
image to make your drawing easier to see. Toggle between 
hiding and showing the template layer using C-Shift -W/
Ctrl-Shift -W, or toggle the visibility icon in the Layers 
panel. If you need to unlock the layer, do so in the Layers 
panel, not the Layer Options dialog.

(Top) The original photo; (bottom) brush strokes 
drawn over the dimmed template photo

Transparent brushstrokes

By default, brushstrokes are 

opaque. You can also draw with 

semi-transparent brushstrokes, 

which you can use to simulate 

some types of inks or watercolors; 

where marks overlap, they become 

richer or darker. Click Opacity in 

the Control panel to reduce opac-

ity or choose a blending mode. 
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2 Customizing a Calligraphic brush. In order to sketch 
freely and with accurate detail, you’ll need to adjust the 
default Paintbrush tool settings. Double-click the Paint-
brush tool to open Paintbrush Tool Options. Drag the 
Fidelity and Smoothness sliders all the way to the left  so 
that Illustrator records your strokes precisely. Disable 
“Fill new brush strokes,” and if you want to be able to 
quickly draw strokes that overlap, disable Keep Selected.

To create a custom Calligraphic brush, click the New 
Brush icon and select Calligraphic Brush. For this piece, 
Steuer chose the following settings: Angle=90°/Fixed; 
Roundness=10%/Fixed; Diameter=4 pt/Pressure/Varia-
tion=4 pt. If you have one of the newer Wacom Art Pens, 
try varying the Diameter with Rotation instead of Pres-
sure, then let the pen barrel rotate between your fi ngers 
naturally as you draw. (If you don’t have a pressure-sen-
sitive tablet, only Random will have any eff ect on varying 
your stroke.) To create a variation of a brush, duplicate it 
by dragging it to the New Brush icon, then double-click 
the copy to edit it. By creating and saving a variety of 
brushes—adding minor variances in Angle, Roundness, 
and Diameter—you can enhance the hand-drawn appear-
ance of your ink drawing by selecting a brushed path and 
choosing a new brush for it.

3 Adding a wash. For this piece, Steuer added depth by 
introducing gray washes underneath the dark brush 
strokes. To easily edit the wash strokes without aff ecting 
the dark ink strokes, create a new layer, and draw your 
wash strokes into this layer between the ink and template 
layers. To avoid altering other layers while you brush in 
the washes, you may want to lock all the other layers. To 
toggle between locking all layers except the wash layer, 
and unlocking all layers at once, including the wash layer, 
Option-click/Alt-click the wash layer’s Lock icon. 

For the wash, select a light color. Steuer used the Dry 
Ink 2 brush from the Artistic_Ink brush library (Swatch 
Libraries menu). In the Layers panel, click the wash layer 
to make it the current drawing layer, and paint away.

2

Customizing the Paintbrush Tool Options

Creating a new Calligraphic brush

Angle, Roundness, and Diameter can be set to a 
variety of Pen characteristics, including Rotation 
if the Pen is one of the newer Art Pens; for mice, 
Random is the only variation from Fixed.

The final ink drawing after adding a couple of 
people not in the original photo, and before 
adding the wash
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G A L L E R Y

Lisa Jackmore

To make interesting brushstrokes, Lisa Jack-

more used variations of Calligraphic and Bristle 

brushes. With a Wacom Intuos4 tablet and Art 

Pen, Lisa Jackmore created variation in some of 

her Calligraphic and Bristle brushstrokes, chang-

ing the parameters of Pressure, Rotation, and 

Tilt. When she wanted to customize a brush, she 

double-clicked the brush, and made changes 

to the options. For the tree outline, she used a 

3-pt Flat Calligraphic brush, set the Diameter 

to Pressure (with a 2-pt variation), Roundness 

to Tilt (34°, with a variation of 15°), and set the 

Angle to Rotation (with a 125° variation). For 

the long sweeping lines of the tree, she found 

the combination of using Rotation and a chisel 

tip of the Art Pen worked the best to vary the 

brushstroke. As she drew, she slightly rotated 

and tilted the pen and created variations in her 

stroke. To create an irregular ink-like appear-

ance in the words, she used a 1-pt Round Cal-

ligraphic brush, and set the Angle to 30° (fixed), 

Roundness to Tilt (60°, with a 29% variation). 

Jackmore used several other variations of Calli-

graphic brushes to draw the suitcases and back-

ground pattern. To make the pattern, she drew 

several paths with a customized Calligraphic 

brush, grouped the brushstrokes, and dragged 

the pattern tile to the swatches panel. After she 

drew all of the black brushstrokes, she colored 

the illustration with a gradient mesh object for 

the background, and used variations of the Fan, 

Round Blunt, and Round Point Bristle brushes 

for other areas, such as the bird, suitcases, and 

shadows. Finally, Jackmore used the rectangle 

tool to make a frame, then applied a Charcoal 

brush to the stroke.

jackmore
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G A L L E R Y

Lisa Jackmore

For designs as fluid as this floral pattern, Lisa 

Jackmore finds that initially drawing with the 

Calligraphic Brush tool is the most natural 

and intuitive way to begin. However, when 

she wants to create specific variations to the 

strokes, she then converts the brushstrokes to 

Basic stroked paths, so she can use the Width 

tool (you can’t use the Width tool on brush-

strokes with a Calligraphic brush). To do this, 

she clicked on the Basic Brush in the Brushes 

panel (the basic stroke version is shown directly 

above). Jackmore then selected the Width tool 

(Shift-W) and clicked on the stroke itself, drag-

ging the handle outwards to evenly widen the 

path. To make adjustments to one side, she held 

the Option/Alt key while dragging the handle. 

To make even further variations to the strokes, 

Jackmore clicked on the stroke, added new 

width points, and adjusted them. She saved sev-

eral Width profiles by selecting each modified 

stroke, clicking on the Add to Profile button in 

the Variable Width Profile menu in the Control 

panel, then naming it and clicking OK. To finish 

the design, she selected each of the remaining 

paths, applied one of her saved width profiles 

from the Control panel, and then increased the 

stroke weight on all of the paths. 

Jackmore
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Stroke Variance 
Creating Dynamic Variable-Width Strokes

Overview: Place sketch and trace 
with Pen tool; modify strokes with 
Width tool; save width profi le and 
apply to other strokes. 

1

2

The original sketch

Traced sketch

Width tool (Shift-W) adjusting middle of stroke

PUtNam

Ryan Putnam creates many character illustrations for 
websites, branding projects, and more. Putnam now uses 
the Width tool to add depth and variance in the strokes 
of the illustrations. Moreover, he can save the stroke 
adjustments to new Width profi les to easily apply to other 
strokes in current and future projects. 

1 Placing a sketch template and tracing with Pen tool. 

Putnam fi rst created a character sketch in Photoshop, 
chose File > Place in Illustrator, enabled Template, and 
clicked OK. Putnam then traced basic paths of the sketch 
with the Pen tool in the layer above.

2 Adjusting strokes with the Width tool. Putnam 
wanted his strokes to have some variance compared to the 
uniform strokes created by the Pen tool. He created two 
distinct stroke widths to use on the majority of the paths 
in the illustration. For the fi rst stroke adjustment, Put-
nam created a stroke with a thicker middle and tapered 
ends. To do this, he used the Width tool to click in the 
middle of the desired path and drag a width point to the 
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desired width. For the second custom width, Putnam cre-
ated a stroke with a thicker end and a tapered end. Again, 
he used the Width tool, but this time clicked on the far 
right side of the desired path and dragged a width point 
to the desired width.

If you like to be precise with your adjustments, you 
can double-click a width point to open the Width Point 
Edit dialog, allowing you to numerically adjust the width 
of the stroke in the Side 1, Side 2, and Total Width fi elds.

3 Saving stroke profi les and applying to other paths. 

Instead of adjusting every path in the illustration to 
match the two custom widths he created with the Width 
tool, Putnam saved time and ensured consistency by sav-
ing his two custom stroke profi les. To save each profi le, 
he selected the modifi ed stroke and clicked the Add to 
Profi les icon in the Stroke panel. With both of his strokes 
saved as custom profi les, Putnam could select a uniform 
stroke, click the saved Variable Width Profi le at the bot-
tom of the Stroke panel, and select the saved profi le from 
the drop-down list. Th ese custom profi les will then be 
available in other new Illustrator fi les.

Aft er Putnam applied the custom profi le to all the 
desired paths, he utilized specifi c keyboard commands 
with the Width tool to further adjust individual paths. 
For example, holding down the Option/Alt key when 
dragging width points creates non-uniform widths, the 
Delete key deletes selected width points, and holding the 
Shift  key while dragging adjusts multiple width points. 
Other Keyboard modifi ers with the Width tool include 
holding down Option/Alt while dragging a width point 
to copy the width point, holding down Option-Shift /
Alt-Shift  while dragging to copy and move all the points 
along a path, Shift -clicking to select multiple width 
points, and using the Esc key to deselect a width point. 

4 Applying fi nishing touches. Putnam added additional 
elements as needed. For instance, he create simple shapes 
with the Pen tool and fi lled them with grayscale colors.

3

Saving new width profile

Applying a saved width profile

Adjusting a path with Width tool and keyboard 
commands

4

Width tool (Shift-W) adjusting end of stroke
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G A L L E R Y

Aaron McGarry

As an illustrator working in the technology 

industry, McGarry created this exploded view 

of a subwoofer from a CAD drawing for use as 

an assembly overview in a re-cone kit. McGarry 

first placed the drawing as a template layer 

then created an oval using the Ellipse tool and 

rotated it to match the angle of the drawing. 

To preserve this angle and shape throughout 

the illustration, he used this first object to cre-

ate all the other ellipses within the illustration 

by holding Option/Alt to make a copy as he 

dragged, and resized using the bounding box. 

McGarry began with the uppermost clamping 

ring and built each component on a separate 

layer; this naturally organized each component 

so that it obstructed the previous components. 

He used an extensive variety of gradients 

from the gradients library (Window > Swatch 

Library > Gradients) to emphasize the cylindri-

cal structure of the speaker. He made a single 

screw, dragged it into the Symbols panel, and 

then used instances of it to create the others. 

To make his customized arrows, he used the Pen 

tool to draw a path, stroked it with a color, and 

then used the Width tool to shape the arrow 

(see process above left). Ellipse strokes such as 

the rim of the black cone also employed the 

Width tool, thinning the stroke as it circled 

away from view. He used the Pen tool to draw 

the red surfaces on the main basket and paths 

forming the cutaway portion of the speaker. 

He then used the Eyedropper tool to sample 

various shades of red from a photo of a similar 

speaker to indicate the red basket shades. 

McGarry
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G A L L E R Y

the chain to reflect the chain vertically. Yukio 

Miyamoto then created the Pattern brush with 

the bead element. He selected and grouped 

the bead. Yukio clicked the New Brush icon at 

the bottom of the Brushes panel, selected New 

Pattern Brush, and clicked OK. In the Pattern 

Brush Options dialog, he kept the Coloriza-

tion method as None, and then under Fit he 

chose Stretch to Fit. To make the necklace, 

Nobuko drew a path with the Brush tool and 

selected the bead Pattern brush in the Brushes 

panel to apply the brush. Now with the bead 

as a Pattern brush, the necklace can be easily 

adjusted to any length or path.

Nobuko Miyamoto/Yukio Miyamoto

Making this intricate beaded necklace at first 

glance would seem impossibly difficult, but 

with the use of a Pattern brush, the neck-

lace virtually draws itself. Nobuko Miyamoto 

designed the necklace and created the bead 

element (detail above) with a mixture of 

blended and solid filled objects. Careful atten-

tion was paid to the ends of the bead to ensure 

that when each bead lined up with the next 

one there would be a seamless connection 

between them. To make the chained ends, she 

selected the chain object and dragged a copy 

(Shift-Option/Shift-Alt) to the other side of 

the bead. With the chain selected, she chose 

the Reflect tool and clicked above and below 

M
iy

a
m

o
to
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Pattern Brushes
Creating Details with the Pattern Brush

Overview: Create the parts that will 
make up a Pattern Brush separately; 
place the parts in the Swatches panel 
and give them distinctive names; use 
the Pattern Brush Options dialog to 
create the brushes.

1

Creating one zipper tooth, using the Blend tool 
for the highlight, then positioning a duplicate to 
mimic the teeth 

Selecting bounding rectangle and objects, drag-
ging objects for Pattern brushes into the Swatch-
es panel, and naming them

maXSoN

While many Illustrator Brushes mimic traditional art 
strokes, Greg Maxson oft en concentrates his eff orts on 
creating Pattern brushes that eliminate the tedious cre-
ation of the practical objects he oft en illustrates. For this 
product illustration, Maxson saved many hours by creat-
ing two zipper brushes, one for just the basic teeth of a 
zipper, and one that included the zipper pull and stop. 
Because he would be able to use these brushes over and 
over again, Maxson knew a little time creating a Pattern 
brush would save him a lot of time in the future. 

1 Creating the parts of the zipper separately. 

Maxson fi rst created the zipper teeth. He drew a simple 
rounded rectangle for the base, and then drew a small, 
light oval on top of a larger black oval that would become 
the highlight. Maxson selected both objects and double-
clicked on the Blend tool to choose Specifi ed Steps, thus 
controlling the brush’s complexity. He used the keyboard 
shortcut C-Option-B/Ctrl-Alt-B to blend the highlight, 
which he placed on the base (you can also blend via 
the menu by choosing Object > Blend > Make). (See the 
chapter Mastering Complexity for more about working 

Adjusting Pattern Brush fi t

After you’ve applied a Pattern 

Brush to a path, you can still scale, 

fl ip, and modify its fi t along the 

path. Modify all these settings in 

the Pattern Brush Options dialog, 

or, manually reshape and scale the 

pattern by changing the stroke 

weight, applying a stroke profi le, 

or using the Width tool. 
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2

Creating zipper pull and stop, oriented in the 
outward-facing position Pattern brushes use for 
their tiles

Creating a Pattern brush with Start and End tiles 
for the zipper with the pull and stop

Creating a new Pattern brush with only a Side 
Tile repeated along the length of the path to 
make the zipper with just teeth

with blends.) Maxson duplicated the zipper “tooth” and 
positioned the copy as it would be in a real zipper. He 
then drew a no-stroke, no-fi ll bounding rectangle behind 
the teeth to add space around each pair of teeth equal 
to the space between each tooth, thus keeping the teeth 
spaced evenly. He selected all the objects and chose Edit > 
Defi ne Pattern. He gave the swatch a name he would rec-
ognize when he built the Pattern brush. Pattern swatches 
are the “tiles” that make up a Pattern brush. 

Maxson then created the pull and stop for the zipper. 
To create the illusion of the pull and stop overlapping the 
teeth, he layered them on top of copies of the teeth he had 
already made. He made sure that the stop and pull were 
facing in the correct direction relative to the zipper pat-
tern tiles (which run perpendicular to the path), and indi-
vidually placed them in the Swatches panel.

2 Making and using the Pattern brushes. To make the 
fi rst Pattern brush for the zipper teeth, Maxson opened 
the Brushes panel’s pop-up menu and selected New Brush. 
He then chose New Pattern Brush, which opened the Pat-
tern Brush Options dialog. He gave his Pattern brush a 
descriptive name, chose the fi rst box in the diagram (the 
Side Tile), and then selected the Pattern swatch that rep-
resented the teeth alone. When a thumbnail of the Pattern 
swatch he had chosen (the teeth) showed in the fi rst box, 
and the other boxes were left  empty, he clicked OK to 
place the brush in the Brushes panel.

To create the version with the stop and pull, he again 
selected New Brush from the Brushes panel, and chose the 
same teeth pattern for the Side Tile. Skipping over the cor-
ner tiles, he chose the Zipper Pull swatch as the Start Tile, 
and the End Tile for the Zipper Stop swatch. He named 
his new Pattern brush so he would know it was built from 
all three swatches and clicked OK.

To use his new brushes, Maxson drew a path for each 
zipper. Th e long, vertical zipper used the brush with the 
pull and stop, while the short zipper used the brush with 
only teeth, since the pull required a unique illustration. 
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Symbolism Basics
Creating and Working with Symbols

Overview: Create a basic back-
ground; defi ne symbols; use Symbol-
ism tools to place and customize 
symbols; add fi nishing details.

Lisa Jackmore created this illustration using a variety 
of eff ects possible with the Symbolism tools. Jackmore 
defi ned a library of symbols and then used the Symbolism 
tools to place and customize the symbols. Symbols can 
provide a “brush-like” painting experience, with easier 
(and more fun!) adjustments and editing.

1 Creating a background and symbols. Because she 
would be drawing many light-colored objects, Jackmore 
began by using the Rectangle tool to draw a blue back-
ground. Locking the layer with the background, Jackmore 
created a new layer on top, into which she drew the art-
work for each of the symbols she would use to create the 
illustration. (See the chapter Your Creative Workspace for 
more on layers.) To turn selected artwork into a symbol, 
either drag it onto the Symbols panel, or press F8; Illustra-
tor automatically takes your artwork on the artboard and 
swaps it for an instance of the symbol. 

2 Applying symbols. Jackmore next selected the grass 
symbol in the Symbols panel and created the fi rst row of 

The artwork for the symbols that were used to 
complete the piece

1

2

The Symbolism tools tear off panel (to tear it off, 
click and hold a tool, then drag to the right edge

The Symbols panel containing the library of 
symbols

One of several symbol sets of the raw grass after 
being sprayed with the Symbol Sprayer tool
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Jackmore used the Symbol Sizer tool to make 
some of the blades of grass larger

3

5

4

grass with a single stroke of the Symbol Sprayer tool. You 
can experiment with the Symbol Sprayer by adjusting the 
Density and Intensity settings (double-click on any Sym-
bolism tool to access the Symbolism Tools Options), and 
the speed of your spray strokes. Don’t worry about getting 
an exact number or precise placement for each symbol as 
you spray; you’ll fi ne-tune those and other symbol attri-
butes next by applying Symbolism tools to a selected set.

3 Resizing symbols. To imply depth, Jackmore applied the 
Symbol Sizer tool to resize blades of grass in a selected 
set. By default, the Symbol Sizer tool increases the size of 
symbols within the tool’s brush radius; to reduce the size 
of symbols within the radius, hold down Option/Alt.

To make the diameter of a Symbolism tool visible, 
double-click on any Symbolism tool and enable the Show 
Brush Size and Intensity checkbox. To enlarge and reduce 
the diameter of a Symbolism tool, use the same shortcuts 
as you do with brushes: the ] key enlarges the diameter, 
and the [ key reduces it.

4 Modifying symbol transparency and color. To modify 
the appearance of a symbol set, use the Symbol Screener, 
Stainer, and Styler tools. Th e Screener tool adjusts the 
transparency of symbols. Th e Stainer tool shift s the color 
of the symbol to be more similar to the current fi ll color, 
while preserving its luminosity. Th e Styler tool allows you 
to apply (in variable amounts) styles from the Graphic 
Styles panel. (For more details about the Styler and 
Screener tools, see Illustrator Help.) Jackmore used the 
Symbol Stainer tool, set to Random, to tint the dandelion 
symbols a lighter shade with just one stroke.

5 Rotating symbols. To make adjustments to the orienta-
tion of the dandelion symbol set, Jackmore used the Sym-
bol Spinner tool set to User Defi ned, which set the spin 
based on the direction that the mouse was moved. (Search 
Illustrator Help for “Symbolism tool options” for an expla-
nation of the User Defi ned and Average modes.)

Jackmore used the Symbol Stainer tool to make 
some of the dandelion symbols a brighter white

Jackmore used the Symbol Spinner tool to rotate 
the dandelion symbols

Symbolism Tools Options 

Quick symbol switching

To switch Sym-

bolism tools, 

hold Control-

Option (Mac) or 

Alt-right-mouse 

button (Win), and click-drag to-

ward the tool you want until the 

icon changes. —Mordy Golding
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6

After using the Symbol Shifter tool with a smaller 
brush size to adjust dandelion symbol positions

Symbol stacking order within a layer

You can change the symbol stacking order within a 

symbol set by adding these modifi er keys to the Symbol 

Shifter tool:

• Shift-click the symbol instance to bring it forward.

• Option-Shift-click/Alt-Shift-click to push the symbol 

instance backward.

Making symbols and keeping the art too

To keep your original artwork on the artboard and use 

it to defi ne a new symbol, hold down the Shift key as 

you drag the artwork onto the Symbols panel.

6 Moving symbols. Jackmore used the Symbol Shift er tool 
with a smaller brush size to adjust the position of the dan-
delion symbol set.

Th e Symbol Shift er tool doesn’t easily move symbols 
across large distances. To maximize symbol movement 
with the Symbol Shift er tool, fi rst make the brush size as 
large as you can—at least as large as the symbol you wish 
to move. Th en drag across the symbol, as though you were 
trying to push the symbol with a broom.

7 Deleting and adding symbols. At this point, Jackmore 
felt there were too many blades of grass. To remove un-
wanted grass, Jackmore used the Symbol Sprayer tool with 
the Option/Alt key held down. She chose a narrow brush 
size and clicked on the blade to be removed. She worked 
on the grass symbol set until she was satisfi ed with the 
amount of grass. When she needed to add more of that 
symbol (or even a diff erent symbol) to a selected symbol 
set, she just applied the Symbol Sprayer tool without any 
modifi er keys.

8 Adding fi nishing touches. To fi nish her illustration, 
Jackmore converted her blue rectangle to a gradient mesh. 
To create the luminous background, Jackmore applied dif-
ferent colors to individual mesh points. For more about 
gradient mesh, see the Color Transitions chapter.

Thinning the grass by removing unwanted grass 
using the Symbol Sprayer tool while holding 
down the Option/Alt key

7

8

The background
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RLSimonson © 2005

the Symbol Options dialog. Simonson drew the 

main body of the bird and began fi lling small 

areas with layers of feathers, using the Symbol 

Sprayer with short strokes to manage their 

placement. To get the look he wanted, he often 

added feathers one by one instead of in looser 

symbol sets. He also applied clipping masks 

to further shape areas of feather symbols. To 

create the glare and the shading, he used the 

Transparency panel to reduce opacity and add 

transparency masks (see the Mastering Complex-
ity chapter for more on masks). He used similar 

methods for adding the seeds. 

Rick Simonson

When Rick Simonson wanted to create a high 

level of verisimilitude in his Chipping Sparrow 

illustration, he turned to Illustrator’s symbols 

as the obvious way to create the hundreds of 

feathers and seeds he would need. He drew 

closed paths for single feathers in the different 

colors and positions necessary to fi ll the bird’s 

body. He added dimension to the feathers with 

gradient fi lls, and he duplicated and rotated 

some feathers to follow the growth pattern of 

real feathers. He then Option-clicked/Alt-clicked 

on the New Symbol icon in the Symbols panel 

to add the selected object without opening 
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Th e myriad Bristle Brushes presented Greg Geisler with 
an infi nite variety of brushes to create his expressive 
painterly portrait, “Blue Mirror.” Commissioned by Adobe 
Systems, you can fi nd this fi le, and a PDF ReadMe fi le 
explaining more about how he made it, on the WOW! DVD 
and in the Sample Art folder installed with Illustrator. 

1 Placing the initial sketch, and customizing Bristle 

Brush Options. Geisler placed his distorted Photoshop 
sketch (PSD) as a Template layer. He opened the Bristle 
Brush Library (Window > Brushes Libraries > Bristle Brush 
Library) and clicked on the 1-pt Round Bristle Brush, 
which automatically loaded the brush into the Brushes 
panel. Geisler next duplicated that brush in the Brushes 
panel (by dragging its icon to the New Brush icon) and 
then double-clicked on the brush in the Brushes panel so 
he could change several settings in Bristle Brush Options. 
He made changes to Bristle Th ickness, adjusted Paint 
Opacity and increased the Stiff ness, and then named it 
and clicked OK. On a layer above the template, he used 
this new brush to create the base sketch for the entire il-
lustration. Geisler kept the Brushes panel and the Bristle 
Brush Library open throughout the drawing session, so he 
could continue to duplicate and customize brushes as his 
drawing progressed. For this layer, he created three diff er-
ent variations of the 1-pt Liner brush. 

Painterly Portraits
Painting in Layers with Bristle Brushes

Overview: Place a sketch as a tem-
plate; draw with customized Bristle 
Brushes; continue to paint with cus-
tom brushes into separate layers; cre-
ate frame.

G
ei

Sl
er

Adding shadows with a wide, fairly opaque 
Bristle Brush

The template; a distorted Photoshop sketch

1

The initial Bristle Brush sketch made with three 
variations of a Round Point Bristle Brush; the 
Bristle Brush Options 
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2 Adding highlights, midtones, and shadows. To make 
one of the many layers of highlights, such as the strokes 
in orange, Geisler customized copies of the 3-mm Flat 
Fan Brush in the Bristle Brushes Library, adjusting Bristle 
Th ickness, Bristle Length, and Paint Opacity. He also 
drew highlights with a Round Bristle Brush customized 
with Pointy variations. Geisler continued to draw in sepa-
rate layers, focusing in particular on midtones, shadows, 
highlights, or color for each layer, using variations of the 
Flat Fan and Round Bristle Brushes.

3 Working effi ciently and further modifying brush 

characteristics. Geisler’s process is very organic in that 
he continually defi nes new brushes, and creates new lay-
ers, as he draws. He rarely deletes a stroke, preferring to 
layer new Bristle Brush strokes upon others, choosing a 
more opaque brush to cover the underlying strokes. As 
he’s drawing, he presses the [ key to decrease the brush 
size, and the ] key, to increase the bristle size. To vary the 
opacity, he presses the keys from 1, which is completely 
transparent, through 0, which is completely opaque. To 
add texture, as in the blue background shown at right, 
Geisler modifi es the settings to increase the brush stiff -
ness toward Rigid, increase the brush density toward 
Th ick, and then decrease the bristle length.

4 Finishing touches. Geisler created an irregular edged 
black frame that surrounded the portrait, on a layer be-
tween the blue texture and the face. He customized a wide 
Flat Fan brush to 100% Opacity (100% opaque Bristle 
Brushes lose their character within the stroke, but main-
tain a ragged edge), and then expanded the brushstrokes 
(Object > Expand) and clicked Unite in the Pathfi nder 
panel, melding the brushstrokes into one frame object. 
He then used the Pencil tool to draw a few closed paths, 
delineating the area between the rectangular frame and 
the head. Marquee-selecting these paths and the frame, 
he fi lled them with black, and again clicked Unite in the 
Pathfi nder panel. 

3

4

2

Adding highlights with a Wide Fan Brush, add-
ing shadows; the Bristle Brush icon that appears 
when using a pressure sensitive pen

Part of the Brushes panel (right), and a later 
stage of the illustration with blue texture

Black frame made with expanded Bristle Brush 
strokes and filled paths shown in Preview mode 
(detail at left), and Outline mode (right) 
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Janaína Cesar de Oliveira Baldacci

Based on a photograph taken by Tatiana 

Bicalho, Baldacci captured the natural undula-

tions of the fur and folds of her pet bulldog 

with Bristle Brushes. Baldacci fi rst drew a white 

outline of the dog (against the black back-

ground) with the Pen tool and applied a Gauss-

ian Blur effect. Baldacci selected Brush Libraries 

Menu > Bristle Brush > Bristle Brush Library then 

selected several brushes to add to the Brushes 

panel. She chose Bristle Brushes that had vary-

ing characteristics in Paint Opacity, Bristle Stiff-

ness, and Bristle Density, such as Round Fan, 

Flat Blunt, Flat Point, and Round Curve (part of 

her Brushes panel shown above). Baldacci then 

selected the Paintbrush tool (B), chose a Bristle 

Brush and a stroke color, and drew into the fi rst 

of many layers (the image on the fi rst layer is 

shown above in Preview and Outline modes). In 

layers above, she added greater defi nition and 

built the fur in stages based on color, such as 

white, gray, and highlights. On the uppermost 

layers she added the snout, eye details, and 

additional layers of fur until the portrait was 

complete.

ceSar de oliVeira BalDacci



Chapter 4 Expressive Strokes 113 

G A L L E R Y

Lisa Jackmore

Lisa Jackmore created this 

pastel-like drawing using 

Bristle Brushes with a Wacom 

Intuos4 tablet and a pressure-

sensitive pen. After placing 

a photograph as a Template 

layer, Jackmore used the Pencil 

tool to make the line drawing 

of the fl owers and leaves. To 

add variation to the stroke, 

she clicked the Variable Width 

Profi le 1 from the Variable 

Width Profi le drop-down menu in the Control 

panel. Next, she set up her work environment 

by opening the Brushes panel, the Bristle 

Brush Library (from the Brush Libraries menu), 

a TRUMATCH Swatch Library, and the Layers 

panel. She also set the Wacom tablet’s Touch 

Ring to auto scroll/zoom, so when she needed 

to magnify an area as she worked, she simply 

turned the Touch Ring clockwise to zoom in, 

and counter-clockwise to zoom out. In order to 

color the inside of the fl ower using the Draw 

Inside mode, Jackmore needed to create a 

simple closed-path outline of each fl ower, leaf, 

and stem (without details). She created the 

outline on a separate layer and then moved 

that layer below the locked outlines layer (left 

detail). To draw into each path, she selected 

it, pressed Shift-D to choose the Draw Inside 

mode (right detail), then deselected the path 

(so the Bristle Brush wouldn’t be applied to the 

outline, instead it would be constrained within 

the path). She selected the Brush tool (B), then 

chose a Bristle Brush, and a TRUMATCH stroke 

color. When she fi nished drawing inside a path, 

Jackmore pressed Shift-D to switch back to Nor-

mal drawing mode, then scrolled to the next 

closed path by dragging the Wacom pen to a 

new area while holding the bottom Express 

key on the tablet. She switched between the 

Brush tool and the Direct Selection tool (press-

ing the C/Ctrl key), and alternated between 

Draw Inside and Normal mode. Jackmore used 

many variations of the Round Point, Fan, and 

Round Blunt Bristle Brushes. Occasionally she 

opened Options (by pressing the upper switch 

on the Intuos4 pen, or by double-clicking the 

Brush tool) to customize parameters for opacity, 

Bristle Length, Stiffness, and Bristle thickness. 

To frame the drawing, she drew two concentric 

rectangles with the Rectangle tool and applied 

a Charcoal Art brush to the strokes.

Jackmore
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Greg Geisler

Greg Geisler created this graphic self-portrait 

using a customized Calligraphic Brush. In the 

Brushes panel, Geisler double-clicked the 

default 3-pt round Calligraphic Brush, and for 

the Diameter settings, he changed Fixed to 

Pressure, and set the Variation to 3 pt. Using 

a Wacom tablet and pressure-sensitive pen, 

he drew the facial outline, varying the stroke 

width as he changed his touch (directly above 

left). To block out planes of color within the 

face (such as the chin, beard, and cheek), 

he used the Pencil tool to draw color-fi lled 

irregular paths on separate layers. Each layer 

contained one of the many defi ning areas of 

color (Layers panel shown above right) for 

highlights, shadows, or texture. To create the 

frame, Geisler used the same Bristle Brush, and 

a technique similar to the one developed in the 

previous lesson (shown below the artwork). For 

fi nishing touches, Geisler drew the bright blue 

squiggly lines with the Pencil tool.

GeiSler
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or change blending modes to Overlay, Multiply, or 

Screen. She alternated between all of these meth-

ods, as well as using the Rotate, Shear, and Scale 

tools, as she built this dynamic portrait.

Cheryl Graham

Cheryl Graham created this vibrant paint-

erly portrait with a custom Art Brush 

designed to mimic a smudged stroke 

made with a charcoal stick. To make 

the “Dreadlock” Art Brush, Graham 

drew ellipses in different sizes with the 

Ellipse tool (left detail). She selected the 

ellipses and applied Pathfi nder > Add 

(middle detail). She then selected the 

Warp tool and smudged the edges of the 

ellipse grouping (right detail). She often 

resized the Warp tool by holding down 

the Option/Alt key while dragging on 

the artboard with the tool to change its 

diameter. Graham selected the artwork 

and dragged it to the Brushes panel to 

make an Art Brush and chose Hue Shift 

to enable quick color changes. She fi rst 

drew the individual strands of hair with 

the Dreadlock brush. To make a basic 

face shape, she drew additional paths 

with the Pen and Pencil tools. She further 

defi ned the face using the Dreadlock 

and default Calligraphy 1 brushes modi-

fi ed in a variety of ways. Graham could 

easily, and dramatically, vary the shape 

and size of the brushes as she painted 

by merely increasing or decreasing the 

stroke width. Occasionally she would click 

fx in the Appearance panel and apply an 

effect to a brushstroke (such as Distort & 

Transform > Tweak). To create transpar-

ency effects, Graham selected brush-

strokes or objects, then clicked Opacity in 

the Appearance panel to reduce opacity 
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accurate brush strokes, while those moved to 

the right were smoother. The “Fill New Brush 

Strokes” and “Keep Selected” options were 

disabled to allow multiple brush strokes to be 

drawn near each other without redrawing the 

last path. Using a pressure-sensitive tablet, the 

students drew varying widths and angles of 

brush strokes, many either on top of or close 

to one another, for a spontaneous, expressive 

look. Extra points within the brush strokes were 

deleted using the Smooth tool or the Delete 

Anchor Point tool. 

Stephen Klema’s Students: 

Dan Brown, Susan E. Alderman, 

Matthew Triompo, Laura McCloskey, 

Shana Popyk, Nicole Gilbertie 

As a class assignment, Professor Stephen Klema 

challenged his students to create expressive 

graphic illustrations of organic forms. The stu-

dents of Tunxis Community College used a vari-

ety of default brushes from the Brushes panel. 

They included both Calligraphy and Art Brushes. 

Before drawing, the students double-clicked 

the Paintbrush tool and adjusted the Paintbrush 

tool preferences. They dragged the Fidelity and 

Smoothness sliders to the desired positions. 

The sliders moved farther to the left had more 

BroWN alDermaN

mccloSkeytriomPo

PoPyk GilBertie
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BUrNett

Stephen Klema’s Students: 

Laura Mottai, Cinthia A. Burnett, 

Jessica Rosario, Emily Looper, 

Theresa Palmer, Kazimiera Cichowlaz

Using the same techniques described on the 

previous page, additional student creations are 

shown above. In some of these illustrations, 

an Art Brush was applied to paths drawn with 

the Pencil and Pen tools. The Pen or Pencil 

path was selected with the Selection tool, then 

a brush was chosen from the Brushes panel. 

The Pen or Pencil path then changed to that 

chosen Brush style. Many types of brushes 

can be found in the Brushes library. To open 

the Brushes library, click on the Brush Library 

Menu icon found in the upper right corner of 

the Brushes panel. Select Open Brush Library > 

Artistic, then select the brushes you want to 

add to the Brushes panel. Find more artwork 

from Professor Klema’s students on his website 

at: www.StephenKlema.com/wow.

mottai

roSario

Palmer

looPer

cicHoWlaZ

www.StephenKlema.com/wow
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Michael Cronan

Continuing with his series of posters for San 

Francisco parks, Michael Cronan created Marina 

Green with his collection of Art Brushes, Scat-

ter Brushes, and Pattern Brushes. He made 

extensive use of brushes that mimic traditional 

media. Adobe Illustrator has provided many 

of these with the program over the years, such 

as Dry Ink, Charcoal, and Pencil. With Scroll 

Pen 5 he could draw a variety of elements, 

from dragon hair to the Golden Gate Bridge 

and the grassy texture of the Marina Green. He 

renamed “Scroll Pen 5” to a more descriptive 

“Scroll Pen Variable Length” in order to fi nd it 

easily in his Brushes panel. He created a Scatter 

Brush for the background stars on the Marina 

Green strip, and modifi ed a Scatter Brush made 

from a fl ying beetle image that he used for one 

of the kites. A Polynesian design made a Pat-

tern Brush that Cronan used to construct the 

dragonfl y kite’s tail, which he drew with the 

Pencil tool. He also drew vector objects and 

basic shapes for some of the elements, and col-

ored them with solid or gradient fi lls.
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a custom Splash brush that included transpar-

ency to represent the koi breaking the surface 

of the pond. Dry Ink and Chalk brushes added 

to the strong texture in this poster. Cronan also 

drew individual fi lled objects that he duplicated 

repeatedly in order to create pattern texture. 

By drawing loosely with the Pencil tool and 

using Pathfi nder commands to break objects 

into abstract patterns, Cronan created informal-

ity and freshness in traditional vector drawing 

that enhanced the Art Brushes’ strokes.

Michael Cronan

To capture the color, ethnic infl uence, and 

spirit of San Francisco’s popular landmarks, 

Michael Cronan not only relies on Art Brushes 

collected over the years, but creates his own. 

To represent the Japanese Tea Garden, Cro-

nan focused attention on the koi pond, creat-

ing the grasses with the Pencil brush and the 

multi-tones of the shrubbery with the Charcoal 

brush (both from: Open Brush Library > Artis-

tic > Artistic_ChalkCharcoalPencil). He created 
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Lance Jackson

To create the cover illustration for the Adobe 
Illustrator CS5 WOW! Book, Lance Jackson gen-

erated atmosphere and depth with the Bristle 

Brush and constructed many of the details using 

the Blob Brush. He used various tools to block 

in the main components of his composition. He 

used the Pen tool to draw the basic cables and 

roadway for the Golden Gate Bridge, then mod-

ifi ed the strokes with the Width tool. Next Jack-

son began brushing over the water and bridge 

with various brushes from the Bristle Brush 

library, especially Deerfoot, Cat’s Tongue, Dome, 

and Fan. To constrain the brushes to each main 

element, he often selected a base object and 

chose the Draw Inside mode. For added tex-

ture, he also used brushes from the Artistic and 

Grunge Brush Vector Pack libraries. Jackson 

drew a few cars and pedestrians using the Blob 

Brush, then duplicated and recolored several of 

them. Jackson toned down his palette, adding 

fog and more depth, by reducing the opacity 

of his brushstrokes, layering the strokes, and 

sometimes even changing the blending mode 

(by clicking Opacity in the Control panel).
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1802 (Pongo), 269
2D

animation and, 262
creating line art, 174
transforming into 3D, 164–166

3D
2D results from, 174
in animation drawings, 178
Bevel & Extrude effects, 56
combining Illustrator with 

Cinema 4D and After 
Effects, 263

combining lllustrator with 3D 
programs, 237

Maya 3D models, 260–261
Revolve and Rotate options, 166
surface shading applied to, 

167–168
transforming 2D shapes into, 

164–166
3D Studio Max, 249
6D Art Pen, from Intuos3, 95
9-slice scaling

enabling symbols for Flash, 93
guides for, 247
symbols and, 239

A
Abneil Software Ltd., 269
Acrobat. see also PDF (Portable 

Document Format), 
236–237

Action Script, 93
Add Anchor Point tool, 147, 

155–157
Add New Fill icon, Appearance 

panel, 202
Add New Stroke option, 

Appearance panel, 47
Adobe Systems, Inc.

Acrobat. see also PDF (Portable 
Document Format), 
236–237

Flash. see Flash
Illustrator. see Illustrator
Photoshop. see Photoshop
as resource, 269

After Effects, 241, 262–263
Ahuja, Anil, 158, 182, 188, 266
AI files

converting to symbols, 245

Create PDF Compatible File, 
232

exporting artwork to Flash, 239
linking vs. embedding, 232
moving Illustrator files to other 

programs, 233
saving with PDF compatibility, 

259
AI_Alpha_1 filter, for softening 

artwork, 181
Alderman, Susan E., 116, 266
Align and Distribute controls, for 

managing objects, 65–66
Align panel, Distribute Spacing 

controls in, 65–66
Alspach, Ted, 178, 266
anchor points

adding, 147, 155–157
Convert Anchor Point tool, 13
drawing objects and, 209
smoothing 3D effects, 166
Snap to Point, 60

angles
Constrain Angle, 5
Smart Guides for custom, 258

animations
2D, 262
creating art for Flash animation, 

248
creating in Flash from 

Illustrator layers, 
244–245

creating with layers, 241
using 3D effects and symbols 

in, 178
anti-aliasing

options, 238
Pixel Preview and, 242
for type, 239
viewing artwork as it would 

appear on web, 
237–238

Appearance panel
accessing appearance details of 

targeted objects, 193
Add New Fill icon, 202
Add New Stroke option, 47
applying effects to brushstrokes, 

115
Distort & Transform option, 53
fx options, 58, 238
Graphic Styles and, 9
important concepts in use of, 8

opacity settings, 56
overview of, 8
type options, 34–35

appearances
applying to path, object, group, 

layer, or sublayer, 8
drawing with, 9
making and applying, 20–21
Shape Builder tool and, 63

Apple Final Cut Pro, 262
Application Frame, turning on/off 

on Macs, 2
apps, combining programs with 

Illustrator
3D programs, 237
Acrobat, 236–237
animation, creating with layers, 

241
copy and paste or drag and 

drop, 233
Flash. see Flash
Flash Catalyst, 240–241
InDesign. see InDesign
linking vs. embedding and, 232
moving Illustrator files to other 

programs, 233
overview of, 232
Photoshop. see Photoshop
save vs. export, 233
web access and, 239–240
Web graphics and, 237–238

Arc tool, using with Pen tool, 17
architectural drawings

applying perspective to, 186–
187

setting scale for, 22–23
symbols used for architectural 

features, 188
Architectural Elements Vector 

Pack, Go Media, 264
arcs

bending labels along, 49
drawing, 17
transforming type with warps 

and envelopes, 52
area type

creating with Type tool, 202
editing area type objects, 203
overview of, 28–29
type objects and, 34
typing or pasting text into box, 

43
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working with threaded text, 
30–31

wrapping around objects, 31
arrowheads

deleting presets, 86
in Strokes panel, 87–89

arrows, customizing, 102
Art Brushes

creating, 89–90
creating parts before animating, 

246
customizing, 119
organic forms created with, 

116–117
overview of, 89–90
paint-like portrait created with, 

115
posters created with, 118
selecting, 55

Art Pens, Intuos4, 95
Artboard Option dialog, 10
Artboard panel

managing artboards, 10–11
renumbering artboards, 36

Artboard Resizer, Premedia 
Systems WOW! 79

Artboard tool
adjusting artboards to fit 

composition, 14
creating/managing artboards 

manually, 10
customizing layout with, 38
Move/Copy Artwork with 

Artboard, 36, 40
placing guides with, 4–5

artboards
copying and duplicating 

artwork on, 39
copying art between, 11
creating client presentation 

from, 40–41
cropping, 259
duplicating artwork on, 148
duplicating elements to, 36
managing, 9–11, 36–37
rulers on, 4
Save for Web options, 237–238
saving project in stages for 

presentation, 79
setting up for different types of 

content, 38–39
artboards, multiple

applying masks across, 198
artistic uses of, 24–25
exporting and printing, 37

what’s new in Illustrator CS5, 
xiii

Artistic Paint brushes
library of, 120
selecting, 55

artwork
creating duplicates of, 149
cropping artwork, 259
finishing in Photoshop, 255
linking vs. embedding, 232
making masks from, 207
mapping onto 3D objects, 179
mapping onto objects, 168–169
splitting into parts for 

animating, 246
turning into symbols, 92, 

106–107
Artwork Colorizer, Premedia 

Systems WOW! 78, 138
Assign mode, Live Color, 130
Astute Graphics Limited, 269
Atteberry, Kevan, 24, 174, 247, 

250, 252–253, 266
attributes, appearance

affects of, 9
copying with Eyedropper tool, 

33
creating for objects, 20–21

Aubé, Jean, 228, 266
Auto Collapse Icon Panels 

command, 3
Autodesk Maya, 260–261
automatic grid, 5
Automatic plane positioning, 171, 

188
auto-scaling art, 22–23
Avenza

MAPublisher, 138
as resource, 269

axes, coordinates of
3D shapes and, 165–166
changing Constrain Angle, 5
scripting moves on, 4

B
backgrounds

adding detail to, 221
creating transparent, 211
creating with radial gradient, 

228
gradient meshes applied to, 108
placing behind objects, 79

Baldacci, Janaína Cesar de 
Oliveira, 112, 266

Baseline Shift
adjusting offset of type from 

type path, 45–46
aligning letters and, 50

Basic Appearance setting, 8
Beauregard, Christiane, 205, 206, 

220, 266
Bergman, Eliot, 260–261, 266
Bevel joins, end cap styles in 

Strokes panel, 88
bevels

3D, 165
error messages and, 166

Bézier curves, 13
blacks, replacing with Live Color, 

150–151
bleed settings

for book cover design, 42–43
designing to edges, 10

Blend tool
creating highlights with, 204
point map technique, 193–194
Smooth Color option, 209

blending modes
applying, 265
choosing, 190–191
Darken, 158
Hard Light, 160
Multiply, 145, 211, 230
overlay and luminosity options, 

56
Screen, 173
Soft Light, 141
transparency and, 190, 226

blends
along a path, 195
applying to warps, 163
combining with gradients and 

transparency, 227
creating, 193–194
creating 3D blends, 214–215
creating glow effect from object 

blend, 217
exporting to Photoshop, 255
extruding 3D blend, 176
for intermediate positions in 

animation, 244
options, 194–195

Bloat, Liquify tool, 160
Blob Brush tool

adding detail with, 120
adding feathered shading with, 

83
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applying, 89
combining objects with, 61–62
features introduced in CS4, xiii
painting over part of letters 

with, 56
refining pencil-and-paper 

sketch with, 76
sketches for animation with, 

244
sketches with, 230
tracing with, 74–75
using on Wacom tablet for 

freehand drawing, 77
bold fonts, 52
book cover design, 42–43
Break Link button, Control Panel, 

93
Bristle Brushes

atmosphere and depth created 
with, 120

loading and using, 79
options in library, 112
overview of, 91
painting in layers with, 110–111
pastel-like drawing created 

with, 113
pressure, rotation, and tilt 

preferences, 98
softening edges with, 230
using with Art Pens, 95
using with tablet or pen, 87
what’s new in Illustrator CS5, 

xiii
Brown, Dan, 116, 266
brushes. see also by individual type

applying to letterforms, 54–55
creating textures with, 221
duplicating, 264–265
mimicking traditional media, 

118
modifying characteristics while 

working with, 111
overview of, 89–91
selecting, 117
transparency used with, 190
washes used with, 96–97
working with, 91–92

Brushes library, 55, 117
Brushes panel

dragging art to/from, 89
New Brush option, 105

brushstrokes. see also strokes
adding interest to, 98
converting to/from basic 

strokes, 99

dynamic variable-width strokes, 
86–89, 95–101

effects added to, 115
effects created with, 248
transparency/opacity of, 96, 120

bullets, using star for, 56
Burnett, Cinthia A., 117, 266
Butt cap, end cap styles in Strokes 

panel, 88

C
CADtools plug-in, from HotDoor, 

258
Calligraphic brushes

customizing, 97
embellishing words with, 257
fluid designs created with, 99
graphic illustration of organic 

forms created with, 
116–117

handwriting with, 55
overview of, 89
pressure, rotation, and tilt 

preferences, 98
self-portrait created with, 114
sizes and shapes of, 158

calligraphy
Blob Brush tool and, 62
creating shadows around, 177
Eraser tool and, 60
using brushes with washes, 

96–97
Chalk brushes, 119
Change to (Global/Artboard ruler) 

command, 4
Character panel

adjusting offset of type from 
type path, 45–46

capitalization options, 36
font options, 50
text formatting, 31
tracking or kerning controls, 49

Character Styles panel, 31
characters

applying styles to, 32
changing shape and spacing 

of, 45
entering with Type tool, 34
special characters in Glyphs 

panel, 35
Charcoal brushes, 118
Chavez, Conrad, 5, 266
Cichowla, Kazimiera, 117, 266

Cinema 4D, from Maxon, 262–263
circles

drawing, 71, 80
drawing concentric, 221
scaling, 80
setting type on, 30

Citron, Scott, 40–41, 42–43, 266
Clear Appearance icon, 21
client files, storing related 

information in, 25
clipping masks

applying, 208–209
building and shading complex 

artwork, 82
creating intricate patterns with, 

220
Draw Inside mode and, 67
Layers panel options, 198–199
Mask button in Control panel, 

199
Object menu command for, 198
overview of, 195–198
type, compound paths, or 

shapes used as masks, 
199

vs. nonclipping masks, 207
clipping paths

clipping masks and, 195–196
maintaining masking effect 

anywhere within layer, 
199

CMKY
blending modes and, 191
process colors and, 123
using Illustrator for web 

graphics and, 238
Cocks, Joel, 230
CodeLine, 269
Cohen, Sandee, 35, 40, 266
color groups

applying, 136
creating, 133
creating with Kuler, 138–139
creating with Live Color, 136
creating/saving based on Color 

Guide, 134–135
in Live Color, 129
overview of, 123–124
placing in Swatches panel, 152

Color Guide panel
creating/saving color groups 

and, 134–135
Edit Colors icon, 128
mixing/matching colors, 

122–123

Blob Brush tool, continued
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Color Guides
Harmony Rules and, 129
overview of, 123–124

Color panel
RGB option in, 133
sliders in, 229
working with, 122–123

Color Reduction options, Live 
Color, 130, 151

color stops
adding to Gradient panel, 

144–145
click-dragging for gradient 

effects, 159
gradients with multiple stops, 

209
positioning, 219

color transitions
color groups and color guides 

and, 123–124
gradient meshes and, 126–127
gradients and, 124–126
Live Color, 128
overview of, 122
recoloring artworks and editing 

colors, 128–130
working with Color and 

Swatches panels, 
122–123

Colorize Method, 151
colors

3D, 165
adding to gradient mesh, 155, 

157
adding to line art, 72–73
applying to layers, 26
applying with Eyedropper and 

Direct Selection tool, 
229

Art Brushes and, 90
basic to complex in composition 

process, 14–15
blending to simulate highlights, 

204
changing layer color, 19
color books accessed from 

Recolor Artwork 
dialog, 148

Color Modes, 133
customizing, 65, 132–133
importing color themes from 

Kuler, 139
matching, 158
merging two or more colors 

into single color, 149

opening color panels in 
Appearance panel, 9

previewing swatches, 63
sampling and applying, 102, 185
scripting, 138–139
smoothing in blends, 194
web-safe, 243

company identity, creating 
graphics package for, 
38–39

composition, basic to complex in 
process of, 14–15

compound paths
clipping masks and, 197
combining objects with, 71
creating, 201
masking with, 199
merging paths to create, 158
options for creating new 

objects, 68
vs. compound shapes, 67

compound shapes
exporting to Photoshop, 235
options for creating new 

objects, 68–69
vs. compound paths, 67

Constrain Angle setting, 5
Constrain Proportions setting, 265
constructing objects

aligning and distributing 
objects, 65–66

Blob Brush tool for combining 
objects, 61–62

compound shapes and paths 
and, 68–69

drawing behind and inside, 
67–68

Eraser tool for cutting objects 
into parts, 60–61

joining objects, 66–67
Live Paint Selection tools for 

recoloring objects, 
63–64

Live Trace tool for rendering 
raster images into 
vector graphics, 64–65

overview of, 60
with Shape Builder, 62–63, 

78–79
context-sensitive menu, for guides, 

43
Control panel

Align and Distribute controls, 
65–66

editing and storing symbols 
from, 90

Embed button, 156
Horizon Align Center icon in, 

16
Live Trace in, 65
Mask button in, 199
Recolor Artwork dialog, 40
setting up artboards and, 10
warp and envelope tools in, 163
working with symbols, 91

control settings, Strokes panel, 
89–90

Convert Anchor Point tool, 13
Convert Layers to Keyframes 

command, 245
Convert to Artboard command, 

11, 37
Convert to Shape command, 202
Cool Extras folder, 4
coordinates, of axes

3D shapes and, 165–166
changing Constrain Angle, 5
scripting moves on, 4

copy and paste
between artboards, 11
building up art from basic 

elements, 15
masks, 199
moving Illustrator files to other 

programs, 233, 241
object management, 7–8
objects to artboards, 36
Paste Into, 265
as Smart Objects, 250–251
text into InDesign, 234

Corel Painter, 264
corners, hand-tracing a template, 

13
course outline, for teaching class 

on Illustrator CS5, xiii
Cressy, Michael, 163, 172, 266
Criscola, Jeanne, 25, 57, 266
Cronan, Michael, 54–55, 118–119, 

266
cropping artwork, 259
curved paths

banner example of, 48–49
blends along, 195
fitting type to, 44–45
labeling curving features on 

maps, 46
type on, 29

curves, hand-tracing a template, 
13
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customizing
angles, 258
arrowheads, 89
Blob Brush tool, 61–62
brushes, 97, 119
brushstrokes, 98
colors, 65, 132–133
gradients, 53, 147
guides, 43
layout, 38
shadows, 54

CValley, Inc., 210, 269

D
Darken, Blending modes, 158
dashed lines, end cap styles in 

Strokes panel, 87–89
Dashwood, Andrew, 148, 266
Del Vechio, Gustavo, 72, 249, 266
depth, creating illusion of, 259
Design Tools Monthly, 269
Device Central, 239–240
devices, designing for expanded 

web access, 239–240
dimensions, reshaping

3D effects, 164–166
envelopes, 163–164
mapping artwork onto objects, 

168–169
overview of, 162
Perspective Grid and, 169–171
surface shading applied to 3D 

effects, 167–168
warps, 162–163

dimensions, setting document 
dimensions, 42

dingbat fonts, Western Bullets 
WF, 56

Direct Selection tool
adding mesh lines, 147
adjusting anchor points and 

direction handles, 13
adjusting direction lines, 201
adjusting shape of mesh object, 

156
applying colors, 229
blending along a path, 195
distorting area type, 29
Group Selection option, 51
reshaping gradient meshes, 127
reshaping paths and characters, 

45
shaping paths, 29

distortion
applying to warps, 163
Distort & Transform option, 

172–173
Distort tools, 127
envelope distort, 172–173, 228

Distribute Spacing controls, in 
Align panel, 65–66

Divide command, pathfinders, 
222–223

docking panels, 3
documents

adding instances of symbols 
to, 92

creating, 16
New Document Profiles, 4
page setup in, 42
placing and refining elements, 

43
setting up for website, 242
tabbed vs. untabbed, 2

drag and drop
brushes, 89
click-dragging for gradient 

effects, 159
Illustrator files to other 

programs, 233
Draw Behind mode, 67, 79
Draw Inside mode

alternating with Normal mode, 
113

Bristle brushes used in, 91
constraining brushes with, 120
constructing objects and, 67–68
creating clipping masks and, 

196
creating shading, texture, and 

details within objects, 
82–83

using with Brush tool, 79
drawing modes

Draw Behind mode, 67, 79
Draw Inside mode. see Draw 

Inside mode
overview of, 67–68

Drees, Dedree, 176, 214–215, 266
Drew, Elaine, 180, 266
drop shadows

applying, 249, 256
complementing 3D effects, 179
creating appearance attributes 

for objects, 21
creating effects, 203
opening panels in Appearance 

panel, 9

Dry Ink brushes, 118, 119
Duplicate Artboards, 40
Duplicate command, 175
DVD, accompanying this book

reference materials on, xvi
what is includes, xiii
ZenLessons folder, xii

E
edges

designing to edge, 10
Hide/Show Edges command, 5

Edit Colors
Color Guide panels, 128
Live Color and, 128

edit icon, locking/unlocking 
layers, 19

Edit mode, Live Color, 130
Edit Symbol button, Control 

Panel, 93
editing

area type objects, 203
clipping masks, 196–197
colors, 128–130, 139, 141, 150
gradient meshes, 147
gradients, 125–126, 224
Illustrator artwork in 

Photoshop, 258
opacity masks, 192
paths in InDesign, 236
symbols, 92–93
transparency, 192–193

effects. see also Live Effects
3D Bevel & Extrude, 56
3D effects, 164–168
accessing in fx menu of 

Appearance panel, 238
adding in Photoshop, 252
applying to brushstrokes, 115
brushstrokes creating, 248
creating textured look with, 58
drop shadows, 203
duplicating, 8
Extrude & Bevel, 178–179, 215
feather. see feathering
Gaussian Blur. see Gaussian 

Blur
glow. see glow effects
gradients, 159
Inner Glow. see Inner Glow 

effects
lighting effects, 265
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maintaining masking effect 
anywhere within layer, 
199

Outer Glow. see Outer Glow 
effects

Roughen effect, 172
rounded styles, 145
saving as Graphic Style, 22–23
Scribble effect, 249
Transform Effect, 11
transparency, 190
twirl, 221

Ellipse tool
drawing circles, 71, 80
drawing concentric circles, 221
drawing in perspective, 182–

183
drawing ovals, 102
icon illustrated with, 132
symmetrical banner created 

with, 48–49
tracing photos, 256

ellipses, using ready-made objects 
in building logo, 13

elliptical gradients, 124, 218–219
Elliptical Marquee tool, 265
Embed button, Control Panel, 156
embedding

importing from Photoshop and, 
235

vs. linking, 232
end caps

changing path look with, 55
choosing natural-looking, 58
in Strokes panel, 87–89

endpoints, joining, 66–67
entourage elements, using library 

of, 264–265
envelope distort

applying to type, 228
bending forms to create organic 

variations, 172–173
envelope mesh, 164
envelope warp, 164
envelopes

compared with warps, 162
converting type to outlines, 32
options for distorting text, 

52–53
overview of, 163–164

EPS files
features not preserved when 

moving files, 233
flattened form of artwork, 194

working with from Illustrator, 
57

Eraser tool
for cutting objects into parts, 

60–61
erasing unwanted marks, 76–77
modifying 3D blends, 215
modifying brush strokes, 62, 75

error messages
bevels, 166
masks and, 199

Every-line composer, for dealing 
with line breaks, 33

Expand dialog, 147
exporting

animations, 241
artboards, 11, 37
artwork to Flash, 239
artwork to Photoshop, 234–235
files, 243
layers to Photoshop, 256
PSD files, 250–251
QuickTime files, 262
SWF files, 239
type, 33
vs. saving, 233

Extrude & Bevel
3D submenu, 165
applying 3D effects, 179
creating 3D objects, 174
extruding 3D blend, 176, 215

Eyedropper tool
applying color to meshes, 147, 

155, 157
sampling and applying color, 

102, 185, 264
using with Direct Selection tool, 

229
using with type, 33

F
Fan Brush, in Bristle Brushes 

Library, 111
feathering

applying effects, 201, 225
for reflection effect, 265
for shading effect, 83

Ferster, Gary, 204, 266
File menu, save options in, 233
files

AI. see AI files
EPS. see EPS files
exporting, 233–234, 243

HTML, 243
JPEG, 243
PDF. see PDF (Portable 

Document Format)
PNG, 11
PSD. see PSD files
QuickTime, 262
SWF. see SWF files
TIFF. see TIFF files

fills
creating and converting to 

shape, 202–203
creating appearance attributes 

for objects, 20
duplicating, 8
Gradient Annotator controlling, 

142–143
gradient mesh, 147
solid color, 218
toggling between stroke and 

fill, 86
transparency and, 190
for type objects, 34–35

filters
in Photoshop, 253, 257
Smart Filters in Photoshop, 251
for softening artwork, 181

Final Cut Pro, Apple, 262
Fit All in Window command, 11
Fit command, 103
Fit to Artwork Bounds command, 

11, 22, 41
Fit to Select Art command, 11
flare

Flare tool, 141
Lens Flare tool, 204

Flash
animation effects in, 241
creating animations from 

Illustrator layers, 
244–245

creating art for Flash animation, 
248

creating symbols for use in, 93
using with Illustrator, 238–239
using with Maxon Cinema 4D 

and Illustrator, 262
Flash Catalyst, 240–241
Flattener Preview panel, 193
flattening artwork, 194
Flesey, Erick, 224, 266
floating type, 202–203
Floor Plane control, in perspective 

drawings, 185, 188
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fonts
with bold characteristics, 52
opening files without correct 

fonts loaded, 35
point sizes, 54
san serif and serif options, 57
selecting typefaces, 51
setting font sizes, 50
type outlines and, 33
vs. outlines, 31
Western Bullets WF, 56

formatting text, 31–32
four color process jobs, 123
Free Transform tool, 15
freehand files, opening/converting 

into multiple artboards, 
36

fx. see also effects
accessing in Appearance panel, 

22, 58
accessing Live Effects from, 162
adding Live Effects to give sense 

of lighting and depth, 
219

applying effects to brushstrokes, 
115

choosing 3D effects, 165

G
galleries, in organization of this 

book, xvi
Gaps settings, Shape Builder tool, 

62
Gaussian Blur

adding to background objects, 
219

applying to words, 257
creating reflection effect, 265
creating shadow effect, 183
Live Effects and, 211
softening transitions, 177

Geisler, Greg, 56, 110, 114, 266
geographic features, on maps 

artwork, 26
geometric drawing, modified keys 

controlling, 60
Giblin, Ian, 65, 266
Gilbertie, Nicole, 116, 266
Gillespie, Cristen, x, xvii
GIS data, importing, 138
Glitschka, Von R., 124, 177, 212–

213, 266
Global Adjust, color adjustment 

sliders, 153
global process colors, 122–123
Global rulers, 4
glossary, on DVD accompanying 

this book, xvi
glow effects

adding to appearance attribute 
set, 20

creating, 205–206, 225
creating from radial gradient, 

216
Inner Glow. see Inner Glow 

effect
Outer Glow. see Outer Glow 

effect
for sense of lighting and depth, 

219
transparency and, 216–217

Glyphs panel, type options in, 35
Golding, Mordy, xiii, xvii, 41, 107, 

149. 162, 163, 237, 266
GoMedia

Architectural Elements Vector 
Pack, 264

clip art from, xiii
as resource, 269

Gordon, Steven, x, xii, xvii, 18, 20, 
26, 46–47, 138, 140, 144, 
202, 242, 266

Grace, Laurie, 244, 266
Gradient Annotator

accessing, 126
controlling fills with, 142–143
creating gradients with, 159
customizing gradients with, 147
editing gradients with, 125–126
rotating gradients with, 219, 224

Gradient Fill pop-up menu, 125
gradient meshes

applying to backgrounds, 108
converting gradients to, 146–

147
converting objects to, 157, 183
creating textures with, 221
overview of, 126–127
using transparency with, xiii, 

154–155, 190, 225
using with Live Color, 131

Gradient panel, 125
gradients

applying to text title, 53
black to white, 256
blends compared with, 193
color stops in, 209
combining with blends and 

transparency, 227
complexity and dimension 

added with, 220
converting to gradient meshes, 

126
creating, 159
editing and selecting, 224
Eyedropper tool used with, 265
filling objects with, 142–143
filling rectangle with, 185
filling square with, 180
Flash and, 239
glow effects created with, 

216–217
grid objects converted to, 183
light and depth added with, 

218–219
from Metals library, 256
within opacity masks, 179
overview of, 124–126
paper fold simulated with, 

144–145
resetting defaults, 127
reusing, 145
transparency used with, 190
unifying across several objects, 

143
Graffix, 269
Graham, Cheryl, 115
Graphic Styles

applying to objects, groups, or 
layers, 9

creating border with Boundary 
style, 41

naming new style, 21
saving and applying, 53
saving effects settings as, 22–23

Graphic Symbol, 241
graphic tablets. see also Wacom 

tablet, 13
graphics, designating symbols as, 

247
grayscale

adjustments, 210
reducing colors to, 152–153

grids
options for, 5
Perspective grid. see Perspective 

grid
positioning elliptical image 

with, 48
Transparency Grid, 190
workspace and, 4–5

Ground Level control point, in 
perspective drawings, 184
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Group Selection option, of Direct 
Selection tool, 51

groups
applying appearances to, 20–21
applying opacity, blend modes, 

or transparency effects, 
190

applying transparency to, 193
assigning style to, 21
blending between pairs of 

grouped objects, 195
color groups. see color groups

Grunge Brush Vector Pack library, 
120

guides
for 9-slice scaling, 247
aligning symbols to, 239
applying globally or to 

individual artboards, 
4–5

for artwork, 243
creating, 5
customizing, 43
for finding vanishing points, 

184
for mesh objects, 154
positioning, 16–17
turning outlines into, 156

H
Habben, Douglas, 269
Hamann, Brad, 200, 266
handwriting, with Pencil tool, 55
Hard Light, Blending modes, 160
Harmony Rules, Adobe

creating/saving color groups 
based on, 135

in Live Color, 129
for mixing/matching colors, 123

Hastings, Pattie Belle, xii, 267
headline, adding arc to, 52–53
Heft, Mimi, 259
help, accessing Illustrator Help, xvi
Hide/Show Edges, 5
hiding/viewing layers, 19
highlights

adding, 111, 204–205
Gaussian Blur effect used for, 

219
simulating, 145
transparency used for, 216–217

Horizon Line control point, in 
perspective drawings, 
184, 187

Horizontal Align Center
aligning artwork, 245
in Control Panel, 16

Hot Door Inc.
CADtools plug-in, 258
as resource, 269

HTML files, 243
Hubig, Dan, 227, 254, 267
hue, adjusting in Photoshop, 257
Huerta, Gerard, 44–45, 267

I
Illustrator

combining apps with. see apps, 
combining programs 
with Illustrator

combining Photoshop with, 
257–258

combining with Cinema 4D and 
After Effects, 263

combining with Maxon Cinema 
4D and Flash, 262

combining with Photoshop and 
Maya, 260–261

creating Flash animations from 
Illustrator layers, 
244–245

features introduced in CS4, xiii
how to use this book, xiv–xvi
InDesign used with, 58
Web page design in, 242–243
what’s new in CS5, xiii
working with EPS files from, 57

images
preparing in Photoshop, 210
resizing, 96
saving slices as, 243

importing
animation effects, 241
from Photoshop, 235
symbols to Flash library, 247

InDesign
page-layout program, 42
pasting text into, 234
using with Illustrator, 58, 236

Inner Glow effects
applying, 201
in Multiply mode, 177

in/out ports
Path type, 29

of text objects, 31
working with threaded text, 

30–31
interlocking objects, creating with 

Pathfinder panel and Live 
Paint, 80–81

Internet. see Web
Intersect pathfinder command, 

71, 212
introduction, in organization of 

this book, xv
Invert Mask command, 192
isolation mode

editing clipping group in, 197
for managing objects, 6
restricting effect of Eraser tool, 

60

J
Jackmore, Lisa, xi, xvii, 98–99, 

106, 113, 146, 221, 267
Jackson, Lance, 76, 120, 267
Jennings, David, 210, 267
Jogie, Mohammed, 179, 267
Johnson, Rick, 258, 267, 269
Join styles

changing path look with, 55
in Strokes panel, 86

joining objects, 66–67
Jolley, Donal, 95, 267
Joly, Annie Gusman, 216, 226, 267
Joly, Dave, 142, 218, 262–263, 267
JPEG files

export options for artboards, 11
for image files, 243
saving sketch as, 74

K
kerning controls, for letter and 

word spacing, 49, 51
keyframes, importing layers 

into Flash as. see also 
animations, 244

keystrokes, in WOW! glossary, xiv
Klema, Stephen, 16, 84, 116, 267
Knockout Groups

creating blends and, 193
exporting blends and, 255
managing layers in Photoshop, 

251
Korn, Peg Maskell, xi, xvii
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Kuler
accessing Kuler themes, 138–

139
using Kuler themes with Live 

Color and Live Trace, 
140–141

L
labels, curving, 49
Landscape option, document 

orientation, 42
Lasso tool, 141, 147
Layer Comp, in Photoshop, 235
layers

appearances applied to, 20–21
blending opacity of, 230
building path layers, 229
creating, duplicating, turning 

off, 259
creating Flash frames from, 239
exporting as PSD files, 250–251
exporting to Flash as keyframes, 

244
highlights, shadows, and 

textures in, 114
importing from Photoshop, 235
master layers, 198
moving objects from Illustrator 

to Photoshop and, 
234–235

naming, 5
opacity, blend modes, or 

transparency effects 
applied to, 190

organizing artwork for web 
pages, 242–243

organizing based on visual 
hierarchy, 200

organizing complex objects, 15
organizing for work in 

Photoshop, 254
organizing into nested 

hierarchy, 18–19, 26
preserving during export to 

Photoshop, 256
reducing opacity of, 226
stacking order of, 108
targeting, 7
working with InDesign and, 236

Layers panel
active clipping mask indicator, 

196

adding highlights, shadows, and 
textures, 114

changing display options of, 19
designing and organizing web 

page content, 242
isolation mode and, 6
masking techniques using, 

198–199
organizing layers based on 

visual hierarchy, 187, 
200

organizing layers into nested 
hierarchy, 18–19

selection and target indicators 
in, 7

using in conjunction with 
Appearance panel, 8

leaders, controlling tabs and, 33
Leavens, Chris, xi, xvii, 82, 267
legacy text, 35
Lein, Adam, xvii, xviii, 5, 267
Lens Flare tool, 204
letter spacing

kerning, 51
maintaining when converting 

type to outlines, 33
warping type and, 49

letterforms, applying brushes to, 
54–55

libraries
accessing Swatches libraries, 

122
Bristle Brushes library, 111–112
Brushes library, 55, 117
of entourage elements, 264–265
Grunge Brush Vector Pack 

library, 120
Metals library, 256
sharing, 39
Swatches library, 122, 126, 133
symbols, 106
TRUMATCH Swatch Library, 

113
lighting

directional, 177
New Light icon, 168
Photoshop used for lighting 

effects, 265
line art

adding color to, 72–73
creating, 174
extruding, 174–175
starting artwork with, 218

line breaks, composition methods 
for dealing with, 33

linear gradients
applying from Swatches panel, 

124
applying to opacity masks, 207
creating, 159
expanding into gradient 

meshes, 146–147
filling objects with, 146
unifying across several objects, 

143
lines, drawing/smoothing, 13
Link Color Harmony button, 149
linking

importing from Photoshop and, 
235

vs. embedding, 232
Liquify tool, 160
Live Color

applying spot colors with, 
148–149

changing color quickly and 
easily, 131

color coding areas on map, 138
creating color variations with, 

137
creating new color groups with, 

136
overview of, 128
recoloring artworks and editing 

colors, 128–130
reducing color to 

monochromatic, 
152–153

replacing blacks with, 150–151
using Kuler themes with, 

140–141
Live Effects. see also effects

accessing, 162
creating sense of interaction 

between objects and 
environment, 177

enhancing lighting and depth 
with, 219

Gaussian Blur, 211
Live Paint tools

adding colors with, 75, 149
Bucket, 63–64
coloring dimensional drawing, 

249
coloring interlocking objects, 

80–81
coloring line art, 72–73
coloring objects with, 15
converting Live Trace to, 65
recoloring objects, 63–64
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Selection tools, 63–64
Live Trace tool

for rendering raster images into 
vector graphics, 64–65

using Kuler themes with, 
140–141

Locate Layer option, in Layers 
panel menu, 19

Locate Object option, in Layers 
panel menu, 19

Lock/Unlock toggle
color wheels, 130
guides, 5, 16
layers, 19

logos
coloring interlocking objects 

on, 80
creating for client, 40–41
designing as part of company 

identity package, 39
digitizing, 12–13
selecting typeface for, 51

Looper, Emily, 117, 267
luminosity option, blending 

modes, 56
Lush, Terrance, 11, 267

M
Mac computers

shortcuts and keystrokes for, xiv
user competence and, xiii

Mac computers, turning 
Application Frame on/
off, 2

Make with Top Object, options for 
distorting text, 52–53

making ends meet, strokes, 88–89
mapping

artwork onto objects, 168–169, 
179

compared with warps, 169
maps

creating with terrain image, 47
geographic features on, 26
organizing layers and sublayers 

for, 18–19
using paths to label curving 

features of, 46
MAPublisher, from Avenza, 138
Maric, Pete, xi, xvii, 186, 264, 267
Mask button, in Control panel, 

199

masks. see also clipping masks
creating glow effects using, 205
opacity masks. see opacity 

masks
for rope shape, 200–201
using Layers panel options, 

198–199
using Object menu command, 

198
master layers

collecting layers into, 198
hiding/viewing, 19
organizing into nested 

hierarchy, 19, 26
targeting, 22–23

Maxon’s Cinema 4D, 262–263
Maxson, Greg, xvii, 104, 267
Maya, from Autodesk, 260–261
McCloskey, Laura, 116, 267
McGarry, Aaron, xi, xvii, 102, 184, 

208, 256, 267
Measure tool, copying art between 

artboards, 11
measurement, setting units of, 4
Mesh tool

creating textures with, 221
deleting mesh points from 

warps or envelopes, 
162

editing meshes, 147
meshes. see also gradient meshes

blends compared with, 193
converting gradients to, 146–

147
mesh points, 126, 162
options for distorting text, 

52–53
Metals library, 256
Microsoft Office, moving objects 

to/from, 235
midtones, adding to artwork, 111
Minus Front pathfinder command, 

71, 80–81, 212
Miter joins, end cap styles in 

Strokes panel, 88
Miyamoto, Nobuko, 103, 267
Miyamoto, Yukio, 103, 159, 267
modified keys, controlling 

geometric drawing, 60
monochromatic color, 152
Motion Tweens, in Flash, 246
Mottai, Laura, 117, 267
mouse, drawing with, 13
Move/Copy Artwork with 

Artboard, 11, 39, 40

movie clips, designating symbols 
as, 247

multiple artboards. see artboards, 
multiple

Multiply mode
blending modes, 145, 211, 226, 

230
Inner Glow options in, 177
Outer Glow options in, 177

Murra Ramirez, Sebastian (mu!), 
160, 267

N
Nahmani, Stephane, 7
naming conventions

artboards, 10
layers, 18
styles, 21

navigating, through artboard 
layers, 11

nested layers, 18–19
New Art Has Basic Appearance 

setting, xv, 167
New Artboard button, 10
New Brush option, 105
New Color Group icon, 15, 124
New Document Profiles

saving artboard configurations, 
10

working with documents, 4
working with Web documents, 

242
New Layer icon, 5, 93–94
New Symbol icon, 109
New Window, options for viewing 

artboards, 10
Nielsen, Chris, xvii, 222–223, 229, 

267
Normal drawing mode, 67

O
object management

Appearance panel for, 8–9
copy and paste techniques, 7–8
isolation mode, 6
overview of, 5–6
selection and targeting 

techniques, 7
Object menu command, 198
objects

applying appearances to, 20–21
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changing to gradient meshes, 
157

combining, 86
composition process for, 14–15
constructing. see constructing 

objects
defining as guides, 5
drawing and filling, 146
envelopes as. see envelopes
interlocking, 80–81
making masks from, 207
mapping artwork onto, 168–

169, 179
preparing for masks, 208
resizing, 203
saving as symbols, 246
type objects, 34–35
using ready-made, 13
wrapping text around, 31

Office, moving objects to/from 
Microsoft Office, 235

Offset paths. see also Baseline 
Shift, 217

one-point perspective view, 
180–181

opacity masks
combining transparency with, 

207
creating and applying, 206–207
glow effects using, 205
gradients within, 179
identifying, 198
overview of, 191–192
softening transitions with, 220

opacity settings. see transparency/
opacity settings

Opacity slider, in Transparency 
panel, 190, 207

OpenType, 35
Options of Selected Object, in 

Brush panel menu, 92
orientation, of blends, 194–195
Outer Glow effects

applying, 228
in Multiply mode, 177
overview of, 47
simulating shadows with, 145

Outline mode, using isolation 
mode as alternative to, 6

outlines
converting type to, 32–33, 45, 

54, 56, 228
filling with color, 158
Outline Stroke options, 201
turning into guides, 156

ovals, creating with Ellipse tool, 
102

overlapping art
across multiple artboards, 11
Art Brushes and, 88
coloring with Live Paint, 80

overlay option, blending modes, 
56, 228

overrides, avoiding text formatting 
overrides, 31

P
page-layout programs, 42
Paidrick, Ann, 131, 154, 156, 157, 

267
paint bucket, using Shape Builder 

as, 63
Paint Strokes, enabling/disabling, 

73
Paintbrush tool

applying Bristle Brush stroke, 
112

customizing, 97
preferences, 116

Painter, from Corel, 264
Palmer, Theresa, 117, 267
panels. see also by individual type

clustering frequently used, 2
for creating/manipulating type, 

28
hiding/viewing, 2
setting up, xv
tips for arranging, 3
for working with color, 122

Pantone color, 40
Papciak-Rose, Ellen, 58, 152, 267
Paragraph panel, 31
Paragraph Styles panel, 31–32
paragraphs, applying styles to, 32
paste. see copy and paste
Paste in Back command, 7–8, 79
Paste in Front command, 7–8, 71, 

79, 207
Paste in Place command, 7–8
Paste on All Artboards command, 

7–8
Paste Remembers Layers, 9
Path Eraser tool, 61
Path type

creating labels, 49
creating paths and adding type 

to, 44–45

labeling curving features on 
maps, 46

overview of, 29–30
setting on curve, 48–49
type objects and, 34
working with threaded text, 

30–31
Pathfinder panel, 69, 80–81
Pathfinders

applying to closed paths, 212
constructing paths using, 70–71
Divide command, 222–223
Minus command. see Minus 

Front pathfinder 
command

Unite command. see Unite 
pathfinder command

paths
blends along, 195
building layers of, 229
clipping masks and, 196
compound paths vs. compound 

shapes, 67
constructing using Pathfinders, 

70–71
creating and adding type to, 

44–45
creating with brushes, 54–55
editing in InDesign, 236
filling with solid color, 218
labeling curving features on 

maps, 46
modifying with Blob Brush 

tool, 61
moving objects from Illustrator 

to Photoshop, 234–235
protecting from Eraser tool, 

60–61
Simplify command, 66

Pattern Brushes
adding detail with, 104–105
creating, 90
making new brush, 105
overview of, 90–91
posters created with, 118
use in necklace design, 103

patterns
fills, 4
for repeating elements, 212–213

PDF (Portable Document Format)
Create PDF Compatible File, 

232
creating multi-page PDF, 40–41
moving other program files into 

Illustrator, 233

object, continued
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printing or saving artboard 
as, 37

saving AI files with PDF 
compatibility, 259

using with Illustrator, 236–237
Peachpit Press, 269
Pen tool

adding small details with, 222
creating art for Flash animation, 

248
creating paths, 44–45, 229
drawing closed path, 183
drawing images, 58
drawing lines, 55
drawing shapes, 44
drawing with, 211, 265
freeform drawings, 72–73, 225
hand-tracing a template, 12–13
simple sketches, 14
tracing with, 100, 228, 256
using with Arc tools, 17

Pencil Art brush, 221
Pencil tool

brushes mimicking traditional 
media, 118

creating detailed image with, 
224

creating icon illustration, 132
creating paths, 44
drawing lines, 55
drawing/redrawing with, 13
handwriting with, 55
labeling curving features on 

maps, 46
reshaping characters with, 45
wavy lines with, 176

perspective, changing perspective 
of an object, 166

Perspective grid
adding background to, 264–265
applying to architectural sketch, 

186–187
basing on photos, 188
creating one-point perspective 

view, 180–181
creating two-point perspective 

view, 182–183
inserting a photo into 

perspective drawing, 
184–185

overview of, 169–171
viewing grid options, 5

Perspective Selection tool, 180, 
183

perspective tools, see also 
Perspective Selection tool, 
Perspective Grid tool,  
what’s new in Illustrator 
CS5, xiii

photographs
basing perspective drawings 

on, 188
as basis for photorealistic art, 

222–223
embedding, 156
inserting into perspective 

drawing, 184–185
scanning, 96
as templates, 256
tracing, 140–141, 228–229

photorealism, 222–223
Photoshop

adding finishing touches with, 
250–251

combining strength of 
Photoshop and 
Illustrator, 256, 257

combining with Illustrator and 
Maya, 260–261

editing artwork in, 258
enhancing images in, 227
exporting to, 234–235
filters in, 253
importing from, 235
lighting effects with, 265
planning ahead to facilitate 

coordination with, 
254–255

preparing images in, 210–211
Smart Objects in, 251
textures and effects added with, 

252
picas and points

scaling to feet and inches, 22–23
setting document dimensions, 

42
Pinabel, Laurent, 20, 268
Pixel grid, 5
Pixel Preview

turning on/off, 242
viewing artwork as it would 

appear on web, 
237–238

pixels, moving objects from 
Illustrator to Photoshop 
and, 234–235

Plane Switching Widget, 181, 187

planes
Automatic plane positioning, 

171
Perspective Grid and, 170–171

plug-ins
CADtools plug-in, 258
on DVD accompanying this 

book, xiii
Xtream Path, 212

PNG files, export options for 
artboards, 11

point map technique, Blend tool, 
193–194

Point type
overview of, 28
type objects and, 34

Popyk, Shana, 116, 268
Portable Document Format. see 

PDF (Portable Document 
Format)

PostScript, 194
power-users, shortcuts and 

keystrokes for, xiv
preferences

for brushes, 91–92, 116
for brushstrokes, 98
for tab documents, 2

Premedia Systems
Artboard Resizer, 79
Artwork Colorizer, 78, 138
as resource, 269

presets, saving grids as, 187
pressure, rotation, and tilt 

preferences, customizing 
brushstrokes, 98

pressure-sensitivity
of Eraser tool, 75
of tablets, 114, 257

Print dialog, 17
Print Tiling tool, 37
printing artboards, 37
process colors, types of solid fills, 

122–123
profiles

New Document Profiles, 4, 10, 
242

stroke profiles, 101
properties

brushstrokes, 92
of Symbolism tools, 94

PSD files
export options for artboards, 11
exporting artwork as, 258
exporting layers as, 250–251
saving blends as, 215
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saving image as, 210
saving sketch as, 74

Pucker tool, reshaping gradient 
meshes, 127

Putnam, Ryan, xi, xvii, 38, 52–53, 
70, 74, 100, 132, 268

Q
QuarkXPress, 42, 57
Quick Reference card, on DVD 

accompanying this book, 
xvi

QuickTime files, 262

R
radial gradients

applying from Swatches panel, 
124

background created with, 228
creating, 159
glow effects using, 216–217
highlights and, 204
transition effect from shadow to 

light, 219
unifying across several objects, 

143
white to black, 205–206, 249

raster effects, creating textured 
look with, 58

raster images
drag and drop and, 233
importing, 43
opening or placing, 65
rendering into vector graphics, 

64–65
Real World Adobe Illustrator CS5 

(Golding), xiii
Rearrange command, artboards, 

10, 36
Recolor Artwork dialog

applying spot colors with, 
148–149

assigning/editing colors with, 
139, 141

changing color of symbols, 
40–41

creating/applying color scheme 
with, 137

editing single color in 
multicolor artwork, 
150

Live Color and, 128–129
Rectangle tool

creating and filling rectangle 
with gradient, 185

creating rectangle for use with 
meshes, 154

drawing in perspective, 182–
183, 188

drawing square with, 180
icon illustration created with, 

132
tracing photos, 256
using in perspective drawings, 

187
using with envelope distort, 172

rectangles
creating, 43, 154
rounding corners of, 70, 145
using ready-made objects in 

building logo, 13
red tip boxes, containing 

warnings, xv
reference point, for resizing 

artboards, 11
references, in organization of this 

book, xvi
Reflect tool

accessing, 172
duplicating symmetrical 

artwork, 16–17
use in necklace design, 103

reflections, creating, 265
registration points, enabling 

symbols for Flash, 93
registration rectangle, bringing 

object into Photoshop 
and, 255

repeating elements, pattern 
making and, 212–213

Reset
in Control Panel, 93
resetting default stroke widths, 

87
reshaping dimensions. see 

dimensions, reshaping
resizing panels, 3
resolution settings, images, 265
Reverse Gradient toggle, 125, 144
Revolve, 3D effects and, 165
RGB (red, green, blue)

blending modes and, 191
selecting Color Mode, 133
using Illustrator for web 

graphics and, 238

Riddle, Michael (Mic), 262–263, 
268

Rosario, Jessica, 117, 268
Rotate, 3D effects and, 165, 224
Roughen effect, Distort & 

Transform option, 173
Round Bristle Brush, 111
Round Corners, effects styles, 145
Round joins, 86
Rounded Rectangle tool

drawing in perspective, 182–
183

working with, 70
Rudmann, Andrew, 14, 268
rulers

customizing guides, 43
pattern fills and, 4
positioning guides with, 16
working with, 4

S
sampling mode, of Eyedropper 

tool, 33
san serif fonts, 57
saturation, adjusting in 

Photoshop, 257
save/saving

artboards as separate files, 37
Save As, 136
Save for Web, 237
Save Workspace command, 2
vs. export, 233

scale
Area type, 28–29
Point type, 28
Scale to Fit, 168
Scale tool, 29, 80
setting scale for architectural 

drawings, 22–23
scanning

adding scanned images to 
templates, 12

images into Photoshop, 210
photos or sketches, 96
shapes, 44
sketches, 174, 200

Scatter Brushes
creating, 90–91
overview of, 89–90
posters created with, 118
symbols compared with, 91

Schumacher-Rasmussen, Eric, xi, 
xvii

PSD files, continued
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Scissors tool
cutting arc with, 17
cutting paths with, 44
making curved path with, 

48–49
Screen, blending modes, 173
Scribble effect, 249
scripts

adding and editing colors, 
138–139

Colorizer script, 78
Select Object Behind, 7
selection indicators, 7
selection techniques

for clipping masks, 199
Live Paint tools and, 73
for managing objects, 7

Selection tool
moving clipping masks with, 

197
scaling type with, 28–29

serif fonts, 57
shading

adding with Blob Brush tool, 83
applying to 3D effects, 167–168

shadows
adding custom blurred shadow 

to type, 54
adding to artwork, 111
creating, 158
paths for, 81
simulating, 145
transparent, 211
using around calligraphy, 177

Shape Builder tool
combining objects into shapes, 

13
constructing objects with, 

62–63, 78–79
preparing objects for use with 

Draw Inside mode, 
82–83

shaving time in constructing 
illustrations, 84

what’s new in Illustrator CS5, 
xiii

shapes
clipping masks, 199
compound paths vs. compound 

shapes, 67
drawing, 200
exporting compound shapes to 

Photoshop, 235
sketching and scanning, 44

sharing artboards and libraries, 39

Shear filter, applying to words, 257
Shinycore Software, 269
Shoglow, Lisa, 257, 268
shortcuts, in WOW! glossary, xiv
Show Transparency Guide, View 

menu, 190
Simonson, Rick, 109, 209, 268
Simplify command, paths, 66
Simulate Colored Paper option, 

190
Single-line composer, dealing with 

line breaks, 33
sketches

applying perspective to, 186–
187

basic to complex in composition 
process, 14–15

basing perspective drawings 
on, 188

creating with Blob Brush tool, 
230

placing as template, 110
refining pencil-and-paper 

sketch with Blob 
Brush, 76

scanning, 96, 174, 200
of shapes, 44
tracing, 74–75

slices
for 9-slice scaling, 247
of image files, 243

Small Caps option, Character 
panel, 36

Smart Filters, in Photoshop, 251
Smart Guides

activating, 17
aligning rectangles with, 80
creating circular shapes, 217
creating repeating patterns, 212
for custom angles, 258
enabling/disabling, 5, 162, 203
using with Pen tool in drawing 

line art, 72
Smart Objects, in Photoshop, 234, 

251
Smooth Color option, Blend tool, 

209, 217
Smooth tool, accessing from Blob 

Brush, 61
smoothing color, in blends, 194
smoothing lines, 13
Snap to Point

creating repeating pattern, 212
moving objects to guide or 

anchor points, 60

Soft Light, blending modes, 141
software, on DVD accompanying 

this book, xiii
solid filled objects, transforming 

into gradient meshes, 126
spine, in curving blends along a 

path, 195
Splash brushes, 119
spot colors

applying with Live Color, 
148–149

selecting, 40
types of solid fills, 122–123

stacking order, of attributes, 9
stacking panels, 3
Star tool, 84
stars, using ready-made objects in 

building logo, 13
Stead, Judy, 86, 268
Steuer, Sharon, (book author), x, 

xii–xiii, xviii, 78, 96, 268
Stretch Between Guides option, 

Art Brushes, 90
Stretch to Fit, 103
Strizver, Ilene, 36, 268
Stroke Weight menu, 47
strokes. see also brushstrokes

adding to type objects, 34
appearance of stroked text, 34
brushes and, 89–91
control settings, 89–90
creating multi-stroked lines, 21
duplicating, 8
increasing weight of, 58
making ends meet, 88–89
making labels standout on 

maps, 47
opening panel for, 9
overview of, 84
resizing, 66
retaining interior strokes in 

drawings, 62
transparency with, 190
types of Symbolism tool, 94
varying width of, 88–91, 95–101
working with brushes, 91–92
working with symbols, 92–94

Strokes panel
control settings, 87–88
dynamic variable-width strokes, 

86–89, 95–101
end cap styles in, 88
opening panels in Appearance 

panel, 9
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styles
formatting text, 31–32
naming and assigning, 21

sublayers
adding to symbol’s artwork, 91
organizing into nested 

hierarchy, 18–19, 26
Sudick, Barbara, 268
surface shading, applying to 3D 

effects, 167–168
Sutherland, Brenda, 137, 268
swatches

accessing Swatches libraries, 
122

adding objects to, 221
choosing color from, 202
creating custom, 133
creating swatch groups, 73
picking colors from, 159
previewing colors, 63
selecting spot color, 40–41
sorting by name, xv

Swatches libraries
accessing, 122
pre-made gradients in, 126
saving swatch in, 133
TRUMATCH Swatch Library, 

113
Swatches panel

applying gradients from, 
124–125

color groups added to, 152–153
New Color Group icon in, 15
saving color groups in, 135
Trash icon in, 122
working with, 122–123

SWF files
creating animation for output 

as, 246
exporting, 239, 241

Symbol Screener tool, 107, 225
Symbol Shifter tool, 108, 225
Symbol Sizer tool, 107, 225
Symbol Spinner tool, 107
Symbol Sprayer tool, 94, 106–109, 

225, 228
Symbol Stainer tool, 107
Symbol Styler tool, 107
Symbolism tools

creating and working with, 
106–107

Options dialog, 92
types of, 94

symbols
aligning to objects or guides, 

239
in animation drawings for facial 

expressions, 178
applying, 106–108
for architectural features, 188
building, 225
changing color of, 41
compared with Scatter brushes, 

89
copying art between artboards, 

11
creating, 228, 245
Flash-ready, 246–247
Illustrator with Flash and, 

238–239
mapping onto 3D objects, 

168–169
replication and quick updates 

with, 39, 109
saving a fabric pattern as, 179
turning artwork into, 36, 106
working with, 50, 92–94

Symbols panel
library of symbols in, 106
modifying symbols with, 92
New Symbol icon, 109

T
tab documents, preference settings 

for, 2
tabs, controlling, 33
Tabs panel, 33
tacking controls, letter and word 

spacing and, 49
targeting

layers, 21
master layers, 22–23
object management and, 7
target indicators, 7
transparency, 192–193

techniques, in organization of this 
book, xvi

Template layer, 12, 96, 174–175
templates

importing artwork using, 96
navigating to folder storing, 4
photos as, 256
placing a sketch template in 

Illustrator, 100
printing artwork to use as, 17
PSD sketch as, 110

scanned image as, 12
sketches as, 74, 174–175, 186

terrain images, on maps, 47
text

arcing, 52–53
creating with Type tool, 208
formatting, 31–32
importing from Photoshop, 235
legibility after adding to 

Photoshop image, 257
pasting into InDesign, 234
saving slices as, 243
using transparency with, 190
working with legacy text, 35
working with threaded text, 

30–31
wrapping around objects, 31

text blocks, 31
text object, 34
Text tool, 49
textures

adding in Photoshop, 252
Roughen effect, 172
use of contrast in, 210
using on book cover, 58
using patterns, brushes, and 

gradients meshes for, 
221

Texturizer effect, 58
threaded text, 30–31
TIFF files

export options for artboards, 11
saving sketch as, 74
web slices and, 234

Tile option, Print dialog, 17, 37
tints

Combine Tints dialog, 151
for indicating time of day, 173
using grayscale conversion for 

generating, 152–153
tips, in organization of this book, 

xv–xvi
titles, arcing text in, 52–53
Tom, Jack, 12, 48–50, 268
Touch Ring, Wacom tablet, 113
tracing. see also Live Trace tool

hand-tracing a template, 12–13
with Pen tool, 100
from photograph, 140, 229, 256
using Live Trace. see Live Trace 

tool
Transform Effect

copying art between artboards, 
11



General Index 285 

for duplicating and scaling art, 
22–23

move artwork a specified 
distance, 36

transparency/opacity settings
adding transparency masks, 109
adjusting, 203
in Appearance panel, 9, 56
applying to backgrounds, 211
applying to meshes, 147, 154–

155, 157
applying to paths, 54–55
blend options, 194–195
blending and unifying with, 

210–211
blending gradients and, 145
blending modes and, 190–191
blends with, 193–194, 214
in Bristle Brushes, 91
of brushstrokes, 96, 120
color matching and, 158
combining with gradients and 

blends, 227
combining with opacity masks, 

206–207
creating with Blending modes, 

226
glow effects and, 216–217
gradient meshes and, xiii, 127, 

225
gradients and, 219
making labels standout on 

maps, 47
opacity masks, 191–192
overview of, 190
preserving during copy and 

paste, 236
reducing opacity in gradients, 

160
for symbols, 94
targeting and editing, 192–193

Trash icon, in Swatches panel, 122
Tremblay, Jean-Claude, x, xii, xiii, 

xvii, xviii, 51, 80, 150, 268
Triompo, Matthew, 116, 268
TRUMATCH Swatch Library, 113
tube shape, creating, 201
Turton, David, 77, 268
Twirl tool

applying to words, 257
creating twirl effects, 221
Liquify tool, 160
modifying 3D blends, 215

two-point perspective
creating details with, 182–183

inserting a photo into 
perspective drawing, 
184–185

type
advanced features of multiple 

artboards, 35–37
anti-aliasing, 239
Appearance panel options, 

34–35
arcing, 52–53
area type, 28–29
converting to outlines, 32–33, 

45, 54, 56, 228
Eyedropper tool used with, 33
floating type, 202–203
formatting text, 31–32
Glyphs panel options, 35
kinds of, 28
making labels standout on 

maps, 47
path type, 29–30
point type, 28
sizing and coloring on poster, 

57
Type Warp, 260
typefaces, 51
using as mask, 199
working with legacy text, 35
working with threaded text, 

30–31
wrapping text around objects, 

31
type objects, 34–35
Type tool

changes due to situational use, 
28

creating area type object, 
202–203

creating text with, 208
entering characters with, 34
tracing photos, 256

Type Warp, 260
typefaces, selecting, 51

U
Unite pathfinder command

constructing paths using, 70–71
pattern making and, 212
using in interlocking object 

project, 80–81
using with shapes, 200

units of measurement, 4, 42

V
vanishing point

guides for, 184
in perspective drawings, 169, 

181
vector graphics

advanced capabilities for, 246
in book cover design, 43
preserving vector format while 

dragging and dropping 
files, 233

raster images rendered as, 
64–65

Vertical Align Bottom, 245
View menu

activating Smart Guides from, 
17

Show Transparency Guide, 190
View modes, options for viewing 

artboards, 10
visibility (eye) icon

hiding/viewing layers, 19, 96
toggling between versions of 

drawings, 23

W
Wacom, as resource, 269
Wacom tablet

drawing lines with, 55
pressure-sensitive pen in, 114
using Blob Brush with, 77
using Bristle Brush with, 89, 113
using with out-of-the-box 

brushes, 95
Warp tool, 115, 160
warps

applying to photos, 256
arcing text, 52–53
bending forms to create organic 

variations, 173
converting type to outlines, 32
creating warped type on labels, 

49
envelopes compared with, 162
mapping compared with, 169
modifying 3D blends, 214–215
overview of, 162–163
reshaping gradient meshes, 127

washes, 97
Watercolor effect, 265
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Web
designing for expanded access 

on, 239–240
Flash Catalyst used for web 

design, 240–241
using Illustrator for web 

graphics, 237–238
web-safe colors, 243
working with Web documents, 

242
Web page, designing in Illustrator, 

242–243
web slices, Photoshop and TIFF 

files and, 234
White, Black Radial gradient, 

205–206
Whyte, Hugh, 134, 268
Width Point Edit dialog, 87
Width tool

adding depth and variance to 
brushstrokes, 100

Stretch Between Guides option, 
90

varying width of strokes, 86–89, 
95–101

Wigham, Laurie, 22, 248, 268
Winder, Darren A., xvii, 225, 268
Window menu, accessing panels 

from, xv
windows, options for viewing 

images, 10
Windows computers

shortcuts and keystrokes for, xiv
user competence and, xiii

wireframes, using for positioning, 
174–175

word spacing
maintaining when converting 

type to outlines, 33
warping type and, 49

Worker72a, 269
workspaces

New Document Profiles, 4
organizing, 2–3
rulers, guides, and grids, 4–5
tips for arranging panels, 3

wrap objects, 31
wrapping text

Area type and, 28–29
around objects, 31

X
x-axis. see also coordinates, of axes, 

165
Xtream Path, from CVally 

Software, 212

Y
y-axis. see also coordinates, of axes, 

165–166

Z
Zappy, Michel, 259, 268
z-axis. see also coordinates, of axes, 

165
ZenLessons folder, on DVD 

accompanying this book, 
xii

Zevrix Solutions, 269
Zig Zag, Distort & Transform 

option, 173
zoom

commands affecting active 
artboard, 11

for drawing smooth lines, 55
before tracing, 65
working on detail and, 222



Windows WOW! Glossary
and essential Adobe Illustrator shortcuts

Ctrl Ctrl always refers to the Ctrl (Control) key
Alt Alt always refers to the Alt key

Marquee With any Selection tool, click-drag over object(s) to select

Toggle Menu selection acts as a switch; 
choose once turns it on, choosing again turns it off

Contextual menu Right-click to access contextual menus 

Group Ctrl-G to group objects together onto one layer

Copy, Cut, Paste, Undo Ctrl-C, Ctrl-X, Ctrl-V,  Ctrl-Z

Select All, Deselect Ctrl-A, Ctrl-Shift-A

  With Paste Remembers Layers on (from the Layers panel menu), pasting from 
Paste Remembers Layers the Clipboard places objects on the same layers that they were on originally; 

if you don’t have the layers, Paste Remembers Layers will make the layers for you

  Use Ctrl-F to paste objects on the Clipboard directly in front of selected
Paste in Front objects, and in exact registration from where it was cut (if nothing is selected, 

it pastes in front of current layer with Paste Remembers Layers off)

Use Ctrl-B to paste objects on the Clipboard directly in back of selected 
Paste in Back objects, and in exact registration from where it was cut (if nothing is selected, 

it pastes in back of current layer with Paste Remembers Layers off)

  
Toggle rulers on/off Ctrl-R

fx menu From the Appearance panel, click the fx icon to access effects

Select contiguous Hold Shift while selecting to select contiguous layers, swatches, etc.

Select non-contiguous Hold Ctrl while selecting to select contiguous layers, swatches, etc.

Toggle Smart Guides on/off Ctrl-U

Turn objects into guides Ctrl-5

Turn guides back into objects Ctrl-Alt-5 (you must select the guide first; if guides are locked, you must unlock 
them first from the contextual menu or from the View > Guides submenu)

  Find related files or artwork in that chapter's folder on the WOW! DVD

Illustrator Help Access Illustrator Help from the Help menu



Object Creation Hold down keys until AFTER mouse button is released.

Constrains objects horizontally, vertically, or proportionally.

Windows Finger Dance 
from The Zen of Illustrator, to help you learn, to “think in Illustrator”*

The current tool becomes the last chosen Selection tool.

Toggles whether Direct Selection or regular Selection tool is accessed by the Ctrl key.

The current tool becomes the Group Selection tool to select entire object. Click again 
to select next level of grouping. To move selection release Option key, then Grab.

Toggles whether an object, path, or point is selected or deselected.

Constrains transformation proportionally, vertically, and horizontally.

Leaves the original object and transforms a copy.

With Direct Selection tool, click on or marquee around an object, path, or point to toggle 
selection/deselection. Note: Clicking inside a filled object may select the entire object.

Clicking on, or marqueeing over objects with Selection tool or Group Selection tool, 
toggles selection/deselection (Group Selection tool chooses objects within a group).

Objects will be drawn from centers.

Opens dialog boxes with transformation tools.

Object Transformation Hold down keys until AFTER mouse button is released.

click

click

click

click

Turns cursor into the Zoom-out tool. Click to Zoom out.

Turns cursor into the Zoom-in tool. Click or marquee around an area to Zoom in.

Spacebar turns cursor into the grabber Hand

Turns your cursor into a cross-hair.

Object Selection Watch your cursor to see that you’ve pressed the correct keys.

Undo. Use Shift-Ctrl-Z for Redo.

*The Zen of Illustrator is copyright ©2011 SHARON STEUER



Object Creation Hold down keys until AFTER mouse button is released.

Constrains objects horizontally, vertically, or proportionally.

Mac Finger Dance 
from The Zen of Illustrator, to help you learn, to “think in Illustrator”*

The current tool becomes the last chosen Selection tool.

Toggles whether Direct Selection or regular Selection tool is accessed by the C key.

The current tool becomes the Group Selection tool to select entire object. Click again  
to select next level of grouping. To move selection release Option key, then Grab.

Toggles whether an object, path, or point is selected or deselected.

Constrains transformation proportionally, vertically, and horizontally.

Leaves the original object and transforms a copy.

With Direct Selection tool, click on or marquee around an object, path, or point to toggle 
selection/deselection. Note: Clicking inside a filled object may select the entire object.

Clicking on, or marqueeing over objects with Selection tool or Group Selection tool, 
toggles selection/deselection (Group Selection tool chooses objects within a group).

Objects will be drawn from centers.

Opens dialog boxes with transformation tools.

Object Transformation Hold down keys until AFTER mouse button is released.

click

click

click

click

Turns cursor into the Zoom-out tool; click to Zoom out.

Turns cursor into the Zoom-in tool; click or marquee around an area to Zoom in.

Spacebar turns cursor into the grabber Hand.

Turns your cursor into a cross-hair.

Object Selection Watch your cursor to see that you’ve pressed the correct keys.

Undo. Use Shift-C-Z for Redo.

*The Zen of Illustrator is copyright ©2011 SHARON STEUER



Mac WOW! Glossary 
and essential Adobe Illustrator shortcuts

C The Command key (this key may have a C or a a on it)
Option The Option key 

Marquee With any Selection tool, click-drag over object(s) to select

Toggle Menu selection acts as a switch; 
choose once turns it on, choosing again turns it off

Contextual menu Right-click to access contextual menus 

Group C-G to group objects together onto one layer

Copy, Cut, Paste, Undo C-C, C-X, C-V,  C-Z

Select All, Deselect C-A, C-Shift-A

  With Paste Remembers Layers on (from the Layers panel menu), pasting from 
Paste Remembers Layers the Clipboard places objects on the same layers that they were on originally; 

if you don't have the layers, Paste Remembers Layers will make the layers for you

  Use C-F to paste objects on the Clipboard directly in front of selected
Paste in Front objects, and in exact registration from where it was cut (if nothing is selected, 

it pastes in front of current layer with Paste Remembers Layers off)

Use C-B to paste objects on the Clipboard directly in back of selected 
Paste in Back objects, and in exact registration from where it was cut (if nothing is selected, 

it pastes in back of current layer with Paste Remembers Layers off)

  
Toggle rulers on/off C-R

fx menu From the Appearance panel, click the fx icon to access effects

Select contiguous Hold Shift while selecting to select contiguous layers, swatches, etc.

Select non-contiguous Hold C while selecting to select contiguous layers, swatches, etc.

Toggle Smart Guides on/off C-U

Turn objects into guides C-5

Turn guides back into objects C-Option-5 (you must select the guide first; if guides are locked, you must unlock 
them first from the contextual menu or from the View > Guides submenu)

  Find related files or artwork in that chapter's folder on the WOW! DVD

Illustrator Help Access Illustrator Help from the Help menu
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